Copyright Notice

Copyright © March 2005 PSIA Corporation. All rights reserved.

No part of this publication may be reproduced or transmitted in any form or by any means (electronic or mechanical, including photocopying) for any purpose without written permission from PSIA. PSIA will not be responsible or liable for any accidental or inevitable damage that may result from unauthorized access or modifications.

This document may contain errors or inaccuracies, and it may be revised without advance notice. This manual is updated frequently.

PSIA welcomes any recommendations or criticism regarding this manual. Customer feedback is always welcome as it helps us to continuously improve upon the quality of our products. If you have any comments or advice, please feel free to contact PSIA.

PSIA Corp
Induspia 5F, SangDaewon-Dong 517-13
Sungnam, Korea 462-120
www.psia.co.kr

PSIA Inc
47339 Warm Springs Blvd.
Fremont, CA 94539
www.advancedspm.com
Preface

This document is an instruction manual for XEI, an Image Processing Program for SPM data developed by PSIA. This manual discusses in detail the software features of the XEI program.

This manual explains the image analysis features in accordance with the standard analyzing features useful for handling SPM data. This document describes, in detail, every item that is displayed in XEI's user interface, and offers a wealth of information regarding the use of a variety of analyzing tools and image processing modes to produce enhanced images. It is quite important to make good use of the XEI image processing program, just as it is important to collect the best possible data utilizing the XEP data acquisition program. The XEI software will allow you to maximize the system's potential, however, by providing the ability to remove certain artifacts from scan data and by allowing you to extract more information from the sample surface by utilizing various analysis tools.

The contents of this manual are organized as follows. First, an overview of the main categories in the XEI is provided so that you may browse for items of interest. Then, the main processing and analyzing tools are more elaborately discussed in each chapter. This software manual pays attention to all available modes and toolbars and discusses their basic functions so that you can apply them to your data with ease.
This is a blank page.
Contents

Chapter 1. Overview of XEI ......................................................... 1
  1-1. Overall Features in XEI .......................................................... 1
  1-2. Title Bar ............................................................................. 2
  1-3. Menu Bar ........................................................................... 2
  1-4. Toolbar .............................................................................. 3
  1-5. Analysis View .................................................................... 3
  1-6. Navigator View ................................................................. 5

Chapter 2. Menus & Toolbar......................................................... 9
  2-1. File ................................................................................... 9
  2-2. Edit .................................................................................. 15
  2-3 Navigator .......................................................................... 16
  2-4. Analysis ........................................................................... 17
  2-5. Process ............................................................................ 23
  2-6. Effect ............................................................................... 28

Chapter 3. Information View ....................................................... 29
  3-1. Information View .............................................................. 30
  3-2. Palette Panel ..................................................................... 30
  3-3. Image Display Panel ......................................................... 33
  3-4. Information Table ............................................................ 35

Chapter 4. Line View ................................................................. 39
  4-1. Line View ......................................................................... 41
  4-2. Selecting Lines for Line Analysis ......................................... 42
  4-3. Line Profile Panel ............................................................... 46
  4-4. Power Spectrum Panel ....................................................... 49
  4-5. Line Histogram Panel ........................................................ 50
  4-6. Line Statistics Table .......................................................... 50

Chapter 5. Region View ............................................................... 53
  5-1. Layout .............................................................................. 55
  5-2 Selecting Region for Region Analysis .................................... 56
Chapter 14. Fourier Filter ...................................................... 127
  14-1. Fourier Filter Process Dialog ............................................. 127
  14-2. 2D Power Spectrum .......................................................... 128
  14-3. Apply the Fourier Filter to an Image .................................... 129

Chapter 15. Tip Estimation ....................................................... 133
  15-1. Tip Estimation Process Dialog ............................................ 134

Index ....................................................................................... 139
Figure Contents

FIGURE 1-1-1. XEI - IMAGE PROCESSING PROGRAM ................................................................. 2
FIGURE 1-2-1. TITLE BAR IN A PREVIEW SCREEN ............................................................... 2
FIGURE 1-3-1. MENU BAR ........................................................................................................ 3
FIGURE 1-4-1. TOOLBAR ......................................................................................................... 3
FIGURE 1-5-1. ANALYSIS VIEW (IN LINE VIEW) ................................................................... 5
FIGURE 1-6-1. NAVIGATOR VIEW .......................................................................................... 5
FIGURE 1-6-2. DRAG AND DROP IMAGES INTO THE NAVIGATOR VIEW ............................. 6
FIGURE 1-6-3. CONTEXT MENU IN THE NAVIGATOR VIEW ................................................... 6
FIGURE 2-1. MENU BAR .......................................................................................................... 9
FIGURE 2-1-1. FILE MENU ..................................................................................................... 10
FIGURE 2-1-2. OPEN DIALOG ............................................................................................... 10
FIGURE 2-1-3. ‘SAVE’ WARNING MESSAGE BOX ................................................................. 11
FIGURE 2-1-4. SAVE AS DIALOG .......................................................................................... 11
FIGURE 2-1-5. PREVIEW SCREEN ......................................................................................... 12
FIGURE 2-1-6. EXPORT DIALOG .......................................................................................... 13
FIGURE 2-1-7. PREFERENCES DIALOG ............................................................................... 14
FIGURE 2-1-8. ‘EXIT’ CONFIRMATION MESSAGE BOX ......................................................... 15
FIGURE 2-2-1. EDIT MENU ..................................................................................................... 15
FIGURE 2-4-1. ANALYSIS MENU AND TOOLBAR ................................................................. 17
FIGURE 2-4-2. INFORMATION VIEW ...................................................................................... 19
FIGURE 2-4-3. LINE VIEW .................................................................................................... 19
FIGURE 2-4-4. REGION VIEW ................................................................................................ 20
FIGURE 2-4-5. GRAIN VIEW .................................................................................................. 20
FIGURE 2-4-6. PSD VIEW ..................................................................................................... 21
FIGURE 2-4-7. 3D VIEW ......................................................................................................... 22
FIGURE 2-4-8. MULTI VIEW ................................................................................................... 22
FIGURE 2-5-1. PROCESS MENU ............................................................................................ 23
FIGURE 2-5-2. CROP PROCESS DIALOG .............................................................................. 24
FIGURE 2-5-3. FILTER PROCESS DIALOG ............................................................................ 25
FIGURE 6-1-4. EFFECT OF FILTERING ON 'WATERSHED' GRAIN DETECTION
Figure 6-1-5. EFFECT OF FILTER LEVEL ON GRAIN DETECTION. GRAIN DETECTION RESULTS
WITH FILTER LEVEL 4 (LEFT) AND FILTER LEVEL 2.5 (RIGHT).
TABLE 6-3-1. GRAIN STATISTICS PARAMETERS.
FIGURE 6-3-1. STATISTICS TABLE
FIGURE 6-4-1. STATISTICS TABLE
FIGURE 7-1. PSD VIEW
FIGURE 7-1-1A. TWO SYNTHETIC IMAGES OF SAME ROUGHNESS
FIGURE 7-1-1B. PSD OF TWO SYNTHETIC IMAGES OF SAME ROUGHNESS
FIGURE 7-2-1A. PSD 2D
FIGURE 7-2-1B. PSD X AXIS
FIGURE 7-2-1C. PSD Y AXIS
FIGURE 7-2-2D. PSD EXPORT
FIGURE 7-3-1. PSD STATISTICS & HISTOGRAM
FIGURE 8-1. PROCEDURE FOR 3D VIEW
FIGURE 8-1-1. LAYOUT OF 3D VIEW
FIGURE 8-2-1. 3D IMAGE DISPLAY PANEL
FIGURE 8-3-1. 3D RENDERING PARAMETERS
FIGURE 8-3-2. SAMPLING NUMBERS
FIGURE 8-3-3. TRANSFORMED 3D IMAGE
FIGURE 8-3-4. ENABLE PERSPECTIVE
FIGURE 8-3-5. SHOW WIRE FRAME
FIGURE 8-3-6. SHOW XY AXIS
FIGURE 8-3-7. SHOW Z AXIS
FIGURE 8-3-8. FILL BORDER
FIGURE 8-3-9. SHOW PLANE
FIGURE 8-3-10. RESTORE DEFAULTS
FIGURE 9-1. PROCEDURE TO GENERATE MULTI IMAGES
FIGURE 9-1-1. MULTI VIEW WITH DIFFERENT NUMBERS OF IMAGES LOADED
FIGURE 10-1-1. CROP PROCESS DIALOG
FIGURE 10-2-1. PROCEDURE TO CROP AN IMAGE
FIGURE 11-1-1. FILTER PROCESS DIALOG
FIGURE 12-1. 1D EXAMPLE OF THE FLATTENING
FIGURE 12-1-1. FLATTEN PROCESS DIALOG
FIGURE 12-1-2. HEIGHT RESTRICTION MARKERS IN THE HISTOGRAM ......................... 117
FIGURE 12-1-3. LINE PROFILES WITH FITTING CURVES.............................................. 119
FIGURE 12-2-1. PROCEDURE TO FLATTEN AN IMAGE..................................................... 121
FIGURE 13-1-1. DEGLITCH PROCESS DIALOG ............................................................ 123
FIGURE 13-1-2. DEGLITCHED IMAGE ........................................................................ 124
FIGURE 13-2-1. PROCEDURE TO DEGLITCH AN IMAGE ............................................. 126
FIGURE 14-1-1. FOURIER FILTER PROCESS DIALOG................................................. 128
FIGURE 14-2-1. 2D POWER SPECTRUM ..................................................................... 129
FIGURE 14-3-1. PROCEDURE TO APPLY THE FOURIER FILTER TO AN IMAGE ............ 131
FIGURE 14-3-2. FOURIER FILTER APPLIED TO ATOMIC LATTICE IMAGE .................. 132
FIGURE 15-1. EXAMPLE OF TIP CONVOLUTION ......................................................... 133
FIGURE 15-1-1. TIP ESTIMATION PROCESS DIALOG ................................................. 134
FIGURE 15-1-2. ESTIMATED TIP SHAPE SAVED AS TIFF FILE ................................. 135
FIGURE 15-2-1. APPLICATION OF TIP ESTIMATION .................................................... 137
Chapter 1. Overview of XEI

XEI is an excellent software program that provides user-friendly and dynamic tools for image processing, quantitative analysis and statistics, and export and printing of processed images and measurement results. This chapter provides an overview of the features and controls in the XEI program so that you can be more familiar with its layout and capabilities.

1-1. Overall Features in XEI

To open the XEI program, double click the XEI icon on your computer’s desktop. Figure 1-1-1 shows the XEI screen appearance that is displayed when starting up the XEI program.
1-2. Title Bar

The Title bar displays the title of the image processing program, XEI. Also, in the preview screen, it indicates the Analysis view type (Information, Line, Region, 3D, and Multi) you want to preview. For example, in Figure 1-2-1, the Title bar indicates that the screen is displaying the preview of the Line view of the selected image.

Figure 1-2-1. Title bar in a preview screen

1-3. Menu Bar

The Menu bar includes several groups of menu items that are available for working with SPM images. A more detailed explanation is provided in Chapter 2. “Menus & Toolbar”. Figure 1-3-1 shows menus, menu items and related icons.
Figure 1-3-1. Menu bar

1-4. Toolbar

The Toolbar, shown in Figure 1-4-1, offers many icons for direct access to the most frequently used basic functions. A more detailed description of the Toolbar is also provided in Chapter 2. “Menus & Toolbar”

Figure 1-4-1. Toolbar

1-5. Analysis View

The Analysis view is a worktable that allows you to work with the selected image and to perform image processing and quantitative analysis on an image. As shown in Figure 1-5-1, the Analysis view of the XEI has three parts: Analysis view tabs, Image display panel and Analysis result & parameters display panel.

Above the Analysis view, there are seven tabs for opening the analysis view: Information, Line, Region, Grain, PSD, 3D, and Multi. When you click each tab, the Analysis view will be switched to the view you selected.
At the left side of the Analysis view, is the Image display panel that displays an image with the palette panel and Histogram panel. You can display the image that you want to process and analyze in the Image display. To bring an image file into the Image display panel, double-click the image from the Navigator view.

**WARNING!**

The contrast color in an image that was generated in the older version XEP program (XEP 1.0) may be reversed. The darker color represents a higher height and the brighter color represents a lower height value. Please, reset the contrast settings so that the brighter color should be the higher height.

In the Image display panel, you can do the following things:

- Load an image from your hard disk into the Image display panel via the Navigator view
- Adjust the color scale of an image with the palette panel
- Preview and print an image in the Image display panel

The right panel of the Analysis view varies according to the selected Analysis view. That is, it displays an information table in the Information view; several data plots in the Line or Region view; and 3D rendering parameters in the 3D view. Also, in the Multi view, the Analysis view displays multiple images at one time. Figure 1-5-1 shows the Analysis view of the Information view. Each Analysis view is described further in each related chapter.
Chapter 1. Overview of XEI

Figure 1-5-1. Analysis View (in Line view)

1-6. Navigator View

The Navigator view serves as a buffer for the images that you have already opened in XEI. You can view basic information of each images in the navigator view by placing mouse pointer over an image. (see the box in Figure 1-6-1)

To load a certain image from the ‘Navigator View’ to the ‘Analysis View’, double click the image you want to load and then click ‘Yes’ to the warning message saying that “This will initialize all the analysis views. Do you want to continue?”

Only one image can be loaded at a time. The loaded image is outlined in blue color and check box beside its name is checked. Figure 1-6-1 shows the Navigator view.

**WARNING!**

When the new image is loaded, the analysis results of the previously loaded image (line profile, statistics table, histogram, etc.) in all the analysis views (Grain, PSD, 3D…) and any changes made by image processing will be removed as all the analysis view is initialized. Therefore you should save all the necessary analysis results and changes made to the image before you load new image to the analysis view from the navigator view.

![Navigator View](image)

Figure 1-6-1. Navigator view

There are three ways to bring images into the Navigator view:

- Drag and drop the selected images from your image directory into the Navigator view (Figure 1-6-2).
- Select the ‘Open’ option in the File menu or click the ‘open data file’ icon to find an image you want to load (Figure 2-1-2).
- Use Send to XEI menu in the buffer window of the XEP.
Figure 1-6-2. Drag and drop images into the Navigator view

When you right-click the cursor on an image in the Navigator view, a context menu as shown in Figure 1-6-3 is generated allowing you to execute the following actions: Load, Reopen, Delete, and Delete All.

Figure 1-6-3. Context menu in the Navigator view
Chapter 1. Overview of XEI

- **Load**
  
  You can load the selected image into the Analysis view for image processing and quantitative analysis.

- **Reopen**
  
  You can reopen the original image again in the Analysis view for a new session or to refresh the image in order to perform image processing and analysis again.

- **Delete**
  
  Removes the selected images from the Navigator view.

- **Delete All**
  
  Removes all images from the Navigator view.
Chapter 2. Menus & Toolbar

The Menu bar contains a list of all available menus from which you can access the basic functions of the XEI image analysis program. Also, the most frequently used menu items are provided as icons on the Toolbar. Figure 2-1 shows the several menu items and the related icons. The underlined letter indicates the hotkey to its related menu or menu item.

Figure 2-1. Menu bar

2-1. File

Contains several menu items that allow you to Open, Save, Save as, Preview, Export and Print image data files as shown in Figure 2-1-1.
Opens the ‘Open’ dialog as shown in Figure 2-1-2. In order to bring an image into the Analysis view, select the ‘File>Open’ in the Menu or click the ‘Open’ icon. Then, select the image file you want to analyze in the Open dialog. This image file is loaded into the Navigator view. If the image file is the first file loaded into the Navigator view, it is automatically loaded into the Analysis view of the Information view. Otherwise, double clicking the image in the Navigator view loads the image into the current analysis view.
2-1-2. Save

Allows you to save the processed image or result in the Image display panel to the original image data file, overwriting the original data. When you select the ‘Save’ menu, the ‘Save’ warning message box as seen in Figure 2-1-3 appears to remind you that this command may replace the original image file.

![Figure 2-1-3. ‘Save’ warning message box](image)

2-1-3. Save As

Opens the ‘Save As’ dialog as shown in Figure 2-1-4. In this dialog, you can save the transformed image or statistics data as a new image data file. Unlike the ‘Save’ menu, it does not overwrite the data in the original data file but create another data file.

![Figure 2-1-4. Save As dialog](image)

2-1-4. Preview

Allows you to preview the processed image with its analysis data. You can export and print this result in the preview mode. As an example of the preview
screen, Figure 2-1-5 shows the preview screen of the selected image in the Line view.

![Figure 2-1-5. Preview screen](image)

**2-1-5. Export**

Allows you to export the data file as a Portable Network Graphics, or ".png" file. This ‘export’ file format is selected by default considering the images’ quality and size. In order to export the data file, select click the ‘Export’ option in the File menu or clicking the ‘Export’ icon and find the directory you want to export the data file. Then, save this file as a new file name. Figure 2-1-6 shows the procedure to export your data file in the ‘Export’ dialog.
Figure 2-1-6. Export dialog
2-1-6. Print

Allows you to print the selected view. Before printing, you can preview the newly processed image or analysis data in the preview screen. This preview can be printed by selecting the 'File>Print' or clicking the print icon 📖.

2-1-7. Preferences

Through the ‘preferences’ menu, you can change several settings in accordance with your preferences. The settings that can be changed from the ‘Preferences’ window are

- Language for the XEI software. English or language of your computer system OS (currently only Korean)
- Whether you would use Move tool or not
- Background color and border settings of the .png files that are created when the analysis view is exported.

![Preferences Dialog](image)

Figure 2-1-7. Preferences Dialog

2-1-8. Exit

You can close the XEI program by selecting the ‘File>Exit’ menu. Then, the
Chapter 2. Menus & Toolbar

'Exit' confirmation message box appears as seen in Figure 2-1-8.

![Figure 2-1-8. 'Exit' confirmation message box](image)

2-2. Edit

Has common function necessary to edit the image for processing and analysis.

Figure 2-2-1 shows several Edit menu items.

![Figure 2-2-1. Edit menu](image)

2-2-1. Undo

Undoes the previous command.

2-2-2. Redo

Redoes the previous command.

2-2-3. Cut

Cuts the selected line or region related to analysis of the image.
2-2-4. Copy

Copies the selected line or region in the image.

2-2-5. Paste

Allows you to paste the cut or copied ‘line or region’ to the location of your choice.

2-2-6. Delete

Deletes the selected line or region of the image in the Analysis view.

2-2-7. Select All

Selects all lines or regions in the image.

2-3 Navigator

2-3-1. Show Navigator

User can choose to show or hide the Navigator View through this command.
Chapter 2. Menus & Toolbar

2-4. Analysis

The Analysis menu provides you direct access to carry out quantitative analysis of the selected line, region, grain and PSD of an image and to view the 3D rendered image. As shown in Figure 2-4-1, the Analysis menu has seven items: Information, Line, Region, Grain, PSD, 3D, and Multi. You can start any one of these analysis by selecting the option in the Analysis menu or by clicking the corresponding analysis tab below the Toolbar.

Figure 2-4-1. Analysis menu and toolbar
2-4-1. Information

In the Information view, you can display the 2D image with basic information of the image that you selected from the Navigator view or loaded by using the ‘Open’ dialog. The Information view shows the original image and much of the scan information associated with the image data. Figure 2-4-2 shows the Information view of the selected image. The Information view is described further in Chapter 3. “Information View”.

2-4-2. Line

In the Line view, you can get information about the cross section or height profile of the surface in the selected image. You can see a Line Profile, a Power Spectrum, and a Line Histogram of a selected line, all at one time. Also, the surface statistics table of the selected line is displayed. Figure 2-4-3 shows the Line view of the analyzed image. A more detailed description of the Line view is offered in Chapter 4. “Line View”.

2-4-3. Region

In the Region view, you can get information about a region of the sample surface in the selected image. You can see a Region Histogram of the selected region as well as a surface Statistics table such as the maximum and minimum height value, mean height and RMS roughness. Figure 2-4-4 shows the Region view of an analyzed image. A more detailed description of the Region view is offered in Chapter 5. “Region View”.

2-4-4. Grain

In the Grain view, user can perform grain analysis on the loaded image. System automatically detects grains in the image, calculates important surface profile parameters of each detected grain, and displays the distribution of surface parameters among detected grains. Figure 2-4-5 shows the Grain view of an analyzed image. A more detailed description of the Region view is offered in Chapter 6. “Grain view”.
Figure 2-4-2. Information view

Figure 2-4-3. Line view
Figure 2-4-4. Region view

Figure 2-4-5. Grain view
2-4-5 PSD

In the ‘PSD View’ user can analyze roughness of the sample surface through PSD graph of the loaded image and obtain relevant data. Figure 2-4-6 shows the PSD view of an analyzed image. A more detailed description of the Region view is offered in Chapter 7. “PSD View”.

2-4-6. 3D

In 3D view, you can view and generate 3D rendered images using many display parameters. The 3D view helps you to see the features of the image and the relationships between those features more clearly. Figure 2-4-7 shows the 3D view of a 3D rendered image. The 3D view is discussed more in Chapter 8.

2-3-7. Multi

In Multi view, you can display and print out several images, up to 6 at a time, with their file name and the palette panel for the contrast and adjustment of the images. You can load multiple images into the empty display panel. Figure 2-4-8 shows the Multi view of the selected images from the Navigator view. A further detailed description is provided in Chapter 9. “Multi View”.

![Figure 2-4-6. PSD view](image)
Figure 2-4-7. 3D view

Figure 2-4-8. Multi view
2-5. Process

The Process menu offers you six image processing tools: Crop, Filter, Flatten, Deglitch, Fourier Filter and Tip Estimation as shown in Figure 2-5-1. Commonly, this Process menu provides several controls for removing artifacts such as high or low frequency noise, curvature and glitches from an image without modifying the actual surface features. Several process dialogs are implemented. You can use one of them from the Process menu or click the icon from the toolbar.

![Process menu](image)

Figure 2-5-1. Process menu
2-5-1. Crop

In the Crop process dialog, you can crop a part of an image which is a region of interest. Figure 2-5-2 shows the Crop process dialog. The Crop menu is described more in Chapter 10. “Crop”.

2-5-2. Filter

Using the Filter process dialog, you can remove some artifacts from the sample surface that are not real data. Figure 2-5-3 shows the Filter process dialog. A further detailed description is offered in Chapter 11. “Arithmetic Filter”.

2-5-3. Flatten

In the Flatten process dialog, you can remove curvatures and slopes from your image data. For more information about the Flatten processing feature, you can refer to Chapter 12. “Flatten” in this document. Figure 2-5-4 shows the Flatten process dialog.

Figure 2-5-2. Crop process dialog
Figure 2-5-3. Filter process dialog

Figure 2-5-4. Flatten process dialog
2-5-4. Deglitch

In the Deglitch process dialog, you can remove small glitches or vertical and horizontal streaks in an image. Figure 2-5-5 shows the Deglitch process dialog. Deglitch is described further in Chapter 13. “Deglitch”.

2-5-5. Fourier Filter

In the Fourier Filter process dialog, you can use the Fourier Filter to remove unwanted frequency components from your data. About the Fourier Filter, consult Chapter 14. “Fourier Filter”. Figure 2-5-6 shown below is the Fourier Filter process dialog.

2-5-6. Tip Estimation

In the Tip Estimation process dialog, you can estimate the shape of the tip used to obtain the image and remove the artifacts generated by tip shape (known as ‘Tip Convolution’) from the loaded image to obtain more accurate image. Consult Chapter 15 for more information on Tip Estimation. Figure 2-5-7 shows the Tip Estimation process dialog.

![Deglitch process dialog](image)

Figure 2-5-5. Deglitch process dialog
Figure 2-5-6. Fourier Filter process dialog

Figure 2-5-7. Fourier Filter process dialog
2-6. **Effect**

2-6-1. **Palette**

You can select the palette that is to be used for the contrast adjustment in the 'Effect>Palette' menu or by clicking the 'Palette' icon.

![Figure 2-6-1. Effect menu](image)

*Figure 2-6-1. Effect menu*
Chapter 3. Information View

In the Information view, the loaded image and its essential information, such as the scan conditions and parameters that were used in acquiring data, are displayed on the XEI screen. You can preview the original image and data through the Information view before performing an image processing or analysis.

![Image Description]

Figure 3-1-1. Information view
3-1. Information View

The Information view is automatically enabled when you execute the XEI program, but you can switch to the Information view from other views by selecting ‘Analysis>Information’ in the Menu or by clicking the Information view tab below the menu bar. Figure 3-1-1 shows the layout of the Information view.

3-2. Palette Panel

The Palette Panel is used to adjust the contrast level range of an image. The Palette panel displays the range of the image data values of the measured signal. Also, the Palette panel shows the relationship between the color of the pixel in the image and corresponding data values of the measured signal. Different colors or shades in the Palette panel represent different height values of the data in the image. The default palette is based on gold color palette scale in which darker colors indicate lower heights and the brighter colors indicate higher height values. As shown in the Figure 3-2-1, there are 3 cursors in the scale bar that indicates the level and range of the scale bar and can be adjusted.

Figure 3-2-1. Palette Panel
3-2-1. Data Range Adjustment

On the left side of the Palette panel, the vertical data scale indicates the height range of the image. By default, maximum (minimum) value of the data range corresponds to the maximum (minimum) data of the pixel data. This data range can be edited by ‘Edit Data Range’ command in the context menu of the palette panel.

- **Full data range**

  Full data range command automatically sets maximum (minimum) value of the data range to the maximum value of the pixel data.

3-2-2. Contrast Range Adjustment

There are two cursors in the palette panel that helps users to change the contrast range. They are Contrast Max and Min cursors. The contrast range is set by adjusting the vertical length of the color palette by dragging these two cursors. Also contrast range can be adjusted by ‘Full Palette range’ command in the context menu of the palette panel.

- **Contrast Max cursor**

  ‘Contrast max’ cursor indicates the data value on the data scale that corresponds to the brightest color of the current color palette (generally white). Any pixels with the data value that exceeds the value indicated by ‘Contrast range max’ will be displayed in brightest color of the color palette (generally white) regardless of their value.

- **Contrast Min cursor**

  ‘Contrast min’ cursor indicates the data value on the data scale that corresponds to the darkest color of the current color palette (generally black). Any pixels with the data value that is under the value indicated by ‘Contrast range min’ will be displayed in darkest color of the color palette (generally black) regardless of their value.

- **Full Palette Range**

  Full palette range command automatically brings ‘Contrast Max’ cursor to the
maximum value of the data range and ‘Contrast in’ cursor to the minimum value of the data range. Therefore, Full palette range command adjusts contrast range such that the contrast range matches the full range of the data range. Thus, the scale maximum corresponds to the data maximum and the scale minimum corresponds to the data minimum.

Adjusting contrast range is useful when you are interested in a specific height range in an image. You can narrow the contrast range so that it covers smaller features in an image (Figure 3-2-2). In this way, you can scale up a specific height range in an image to see smaller features in greater detail.

![Figure 3-2-2. Contrast range adjustment](image)

3-2-3. Contrast Level Adjustment

‘Contrast level marker’ is a red line on the palette panel. ‘Contrast level marker’ indicates the data value on the data scale that corresponds to the middle of the current color palette. As shown in Figure 3-2-3, the contrast level is adjusted by click and dragging the ‘Contrast level marker’ on the palette panel.
3-2-4. Palette Change

You can change the palette for the contrast adjustment by selecting the ‘Palette’ option in the Effect menu (see Figure 2-6-1).

3-3. Image Display Panel

As shown in Figure 3-3-1, the Image display panel shows the 2D image you selected in the Navigator view.

3-3-1 Loading Image to the Image Display Panel

When you want to change the image in this panel, you can double-click another image in the Navigator view. At this time, you can see the ‘Load’ confirmation message box which asks if you want to initialize the selected image (Figure 3-3-2).
Figure 3-3-1. Image display panel of the Information view

Figure 3-3-2. ‘Load’ confirmation message box

3-3-2 Export

Tiff file loaded in the XEI can be exported in forms of text file or image file (jpg, png, bmp) from the ‘Export’ command in the context menu of the Image display panel. Tiff file consists of two part, scan data part and image part. When tiff file is exported in text file, the file will contain basic information about the tiff file and data array of the scan data. On the other hand, when tiff file is exported in image file, exported image file only takes image of the tiff file but not the scan data within it.
3-4. Information Table

When scan image file is generated from XEP software, various information and scan parameters used to obtain image is saved along with the image itself. As shown in Figure 3-4-1, these can be viewed through the Information table. Clicking 'Show Details' button will display every information and parameters saved with the image. Click 'Hide Details' button to view only the important information and parameters, summarized. Meaning of the each items found in the Information table is given in the Table 3-1.

<table>
<thead>
<tr>
<th>Item</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Name</td>
<td>Indicates the file name of the generated image that was saved after scanning.</td>
</tr>
<tr>
<td>PSIA TIFF Version</td>
<td>Indicates the tiff version of PSIA software that created the image file. XEI 1.5 supports tiff file below 1.0.2</td>
</tr>
<tr>
<td>Comments</td>
<td>Shows the comments you edited in the Image Information dialog of the XEP or XEI.</td>
</tr>
<tr>
<td>Head Mode</td>
<td>Indicates the Head mode such as AFM, NC AFM, MFM, LFM, EFM, FMM and so on. It was selected in the XEP Part Selection dialog.</td>
</tr>
<tr>
<td>XY Voltage Mode</td>
<td>Indicates the voltage mode of the XY scanner (high or low) during imaging. This parameter is set from the Part Config dialog box in XEP.</td>
</tr>
</tbody>
</table>

Figure 3-4-1. Information table (Hide Details)

Table 3-2. Items in the detailed Information table

<table>
<thead>
<tr>
<th>Item</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Name</td>
<td>O8um.tiff</td>
</tr>
<tr>
<td>Head Mode</td>
<td>NC-AFM</td>
</tr>
<tr>
<td>Source</td>
<td>Topography</td>
</tr>
<tr>
<td>Data Width</td>
<td>512 (pxl)</td>
</tr>
<tr>
<td>Data Height</td>
<td>512 (pxl)</td>
</tr>
<tr>
<td>X Scan Size</td>
<td>9.04 (μm)</td>
</tr>
<tr>
<td>Y Scan Size</td>
<td>9.04 (μm)</td>
</tr>
<tr>
<td>Scan Rate</td>
<td>0 (Hz)</td>
</tr>
<tr>
<td>Set Point</td>
<td>0 (unit)</td>
</tr>
<tr>
<td>Data Gain</td>
<td>-1.4567E-6 (μm/step)</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Z Voltage Mode</strong></td>
<td>Indicates the voltage mode of the Z scanner (high or low) during imaging. This parameter is set from the Part Config dialog box in XEP.</td>
</tr>
<tr>
<td><strong>Z scanner range</strong></td>
<td>Indicates the range of Z scanner (0 to 1 corresponding to 0 to 12um range of the Z scanner) during imaging. This parameter is set from the Part Config dialog box in XEP.</td>
</tr>
<tr>
<td><strong>Source</strong></td>
<td>Indicates the input signal source that was used to acquire an image. This Source was selected in the Input Configuration dialog of the XEP image acquisition software.</td>
</tr>
<tr>
<td><strong>Low Pass Filter</strong></td>
<td>Indicates the time interval used to generate the averaged data pixel so that high frequency noise can be eliminated. The higher value of the LPF means that a longer time interval is permitted to generate each pixel. This parameter was adjusted in the Input Configuration dialog in XEP.</td>
</tr>
<tr>
<td><strong>Plain Fit</strong></td>
<td>When turned On, Plain fit keeps the average level of each line of data constant so that the contrast scale does not saturate while an image is being generated. This parameter was selected in the Input Configuration dialog.</td>
</tr>
<tr>
<td><strong>Flattening</strong></td>
<td>Shows the type of flattening applied to the image during data acquisition process, if any flattening was selected from the Input Configuration dialog.</td>
</tr>
<tr>
<td><strong>Data Width</strong></td>
<td>Indicates the pixel size of an image in the x direction. This parameter was selected in the Scan Configuration dialog.</td>
</tr>
<tr>
<td><strong>Data Height</strong></td>
<td>Indicates the pixel size of an image in the y direction. This parameter was selected in the Scan Configuration dialog.</td>
</tr>
<tr>
<td><strong>Sine Scan</strong></td>
<td>When it is On, indicates that the sine scan was applied to an image while scanning. This parameter was selected in the Scan Configuration dialog.</td>
</tr>
<tr>
<td><strong>Over Scan</strong></td>
<td>Indicates the percentage that an over scan was applied to an image while scanning. This parameter was selected in the Scan Configuration dialog.</td>
</tr>
<tr>
<td><strong>Fast Scan Axis</strong></td>
<td>Indicates the scan direction that was selected to acquire each line of data in compiling the image. This parameter was selected in the X, Y check box in the Scan control window of XEP.</td>
</tr>
<tr>
<td><strong>Fast Scan Dir</strong></td>
<td>If the fast scan axis is X, indicates that the fast scan direction is from left to right or from right to left.</td>
</tr>
<tr>
<td><strong>Slow Scan Dir</strong></td>
<td>If the fast scan axis is X, indicates that the slow scan direction is from bottom to top or from top to bottom.</td>
</tr>
<tr>
<td><strong>X Scan Size</strong></td>
<td>Indicates the scan size of an image in the x direction. This value was set in the Scan control window of XEP.</td>
</tr>
<tr>
<td><strong>Y Scan Size</strong></td>
<td>Indicates the scan size of an image in the y direction. This value was set in the Scan control window of XEP.</td>
</tr>
<tr>
<td><strong>X Scan Offset</strong></td>
<td>Indicates the X offset coordinate relative to the scanner midpoint (0, 0) that was used to define the scan area. This value was set in the Scan control window of XEP.</td>
</tr>
<tr>
<td><strong>Y Scan Offset</strong></td>
<td>Indicates the X offset coordinate relative to the scanner midpoint (0, 0) that was used to define the scan area. This value was set in the Scan control window of XEP.</td>
</tr>
<tr>
<td><strong>Rotation</strong></td>
<td>Indicates the degree of rotation that the fast scan direction was rotated relative to the X axis or the Y axis while an image was generated. This parameter was adjusted in the Scan control window of XEP.</td>
</tr>
<tr>
<td><strong>Scan Rate</strong></td>
<td>Indicates the frequency that the scanner is rastering back and forth across the sample surface. This parameter was adjusted in the Scan control window of XEP.</td>
</tr>
<tr>
<td><strong>Set Point</strong></td>
<td>Indicates the set point value adjusted in the Scan control window or Frequency Sweep dialog. Depending on the scan mode, the meaning of this value may differ for different scan modes.</td>
</tr>
<tr>
<td><strong>Tip Bias</strong></td>
<td>Indicates the voltage that was applied to the tip with the sample being grounded to investigate the interaction between the tip and sample while scanning. Depending on your instrument, either a tip bias or a sample bias can be applied. This can be adjusted in the Scan control window of XEP.</td>
</tr>
<tr>
<td><strong>Sample Bias</strong></td>
<td>Indicates the voltage that was applied to the sample with the tip being grounded to investigate the interaction between the tip and sample while scanning. Depending on your instrument, either a tip bias or a sample bias can be applied.</td>
</tr>
</tbody>
</table>
applied. This can be adjusted in the Scan control window of XEP.

Data Gain  The real data is obtained by multiplying the raw data and data gain itself.

Z servo gain  Indicates the value of Z servo gain set during the imaging process.
Chapter 4. Line View

In the Line view, you can measure and analyze several characteristics of an image along selected line profiles. Select the line type (for example, vertical, horizontal, or slanted), and generate the line on the image across the profile you want to measure and analyze. You can make quantitative measurements of surface features and collect surface statistical data along the cross section. The Line view provides a Line Profile, a Power Spectrum, and a Histogram of the line profile.

In general, you can analyze the selected lines in your image in the Line view through the following steps:

1. Select an image you want to analyze in the Navigator view.
2. Enable the Line view.
3. Click the desired line type button on the line selection toolbar that is at the higher right side of the displayed image.
4. To draw a line, drag the mouse across the profile you wish to analyze.
5. The measurement results will appear in several panels and a statistics table.
6. Save and print your Line view results if desired.

Figure 4-1 shows the summarized procedure to analyze the selected line in an image.
Figure 4-1. Procedure for Line view
4-1. Line View

To enable the Line view, select ‘Analysis>Line’ from the menu bar or click the Line analysis tab below the Toolbar. The layout of the Line view is divided into three main regions; Image display panel, Analysis plots panel, and Statistics table. Figure 4-1-1 shows the Line view of the horizontal line in the image.

![Line view](image)

Figure 4-1-1. Line view

4-1-1 Palette Panel, Image Display Panel and Histogram

Just as in other Analysis views, the image you want to analyze can be displayed in the Image display panel with the Palette Panel. It is the same Palette Panel and Image Display Panel that appears in all the analysis views of XEI. Please refer to Chapter 3-2 and 3-3 for details. Also the histogram of the entire image surface is displayed on the bottom of the Image Display Panel as in the other analysis views.
4-1-2 Line Selection toolbar

Line selection toolbar, where the Tools for selecting line for the analysis are gathered, is at the right side of the image Display Panel.

4-1-3 Line Profile, Power Spectrum and Line Histogram Panel

Line Profile, Power Spectrum, and Line Histogram is generated immediately on the separate panel after you create a line across the image for line analysis. These plots are automatically updated whenever you select the line and move the selected line in the image. Detailed features of these three panels are explained in section 4-3, 4 & 5 respectively.

4-1-4 Line Statistics Table

In the Line Statistics Table, the statistics table of the quantitative measurements up to three selected lines (classified by different colors: red, green, and blue) is displayed. The related values of the selected lines are changed in accordance with the change in position of the cross section. Detailed features of the Line Statistics Table are explained in section 4-6.

4-2. Selecting Lines for Line Analysis

To get reasonable information of line profile of the sample, it is important to select specific lines for analysis. Line selection toolbar contains various tools that help you to select precise lines for line data analysis. The process of selecting line for analysis is done in three steps.

Step 1. Select Type of the Line

You can create up to three lines for line profile analysis on the image (see Figure 4-2-1): vertical, horizontal and/or arbitrarily sloped lines are possible. Each line you create is indicated by a different color (red, green, and blue in order) in the Image display panel as well as in the analysis plots.
Step 2. Create the Line

- Horizontal or vertical line

Click the horizontal or the vertical line button on the line selection toolbar to generate a horizontal or vertical line to be analyzed as a cross section of the sample surface. Then, click the cursor at any location on the image where you would like to analyze the height profile. The colored horizontal or vertical line will appear in the image. You can easily move the line for analysis anywhere in the image by dragging and dropping the line again and again. Figure 4-2-2 shows an example of moving a horizontal line for analyzing different image cross sections.
**Figure 4-2-2. Move a line for Line view**

- **Slanted line**

  As shown in Figure 4-2-3, after clicking the slanted line button, press the cursor onto any location where you would like to start the arbitrary slanted line. Drag and drop the cursor onto the end point of this line. To change the location of the line, follow the same procedure as for a vertical or horizontal line. Furthermore, you can resize the line by clicking the line to display circular trackers at the two end points of the line. Then, drag and drop these trackers.
**Figure 4-2-3. Create a slanted line**

### Step 3. Edit the created Line

You can move, delete and resize the line created in step 2 with the help of the ‘Move tool’. Move tool only appears on the toolbar only if you have checked ‘Line’ check box from the ‘Use Move Tool’ option in the ‘Preferences Window’.

When the ‘Use Move Tool’ option for the ‘Line’ is checked, mouse pointer stays in ‘line selection’ (cross hair mouse pointer) mode so that user can continuously create line for line analysis one after another. Mouse pointer will stay in ‘line selection’ mode unless you click ‘Move Tool’ button to exit ‘line selection’ (cross hair mouse pointer) mode and switch to ‘line edition’ (arrow mouse pointer) mode. On the other hand, when the ‘Use Move Tool’ option for the ‘Line’ is not checked, the mouse pointer will automatically switch from ‘line selection’ (cross hair) to ‘line edition’ (arrow) mode each time you create a line.

#### Selecting

First, select the line corresponding to the line shape you would like to edit. Next, click ‘Move tool’ to enable the line edit. Click on the line you would like to move to select it. You can also select multiple line by pressing ‘Ctrl’ key as you click multiple line. To select all the lines, press Ctrl+A or select ‘Select All’ in the context menu.
Moving

The mouse cursor changes to four arrow cursor and selected line is marked by circular tracker around it. You can move the selected line by dragging it.

Deleting

To delete the selected line, select delete command from the context menu or press delete button.

Changing Shape

In case of slanted line, you can resize the line by clicking the line to display circular trackers at the two end points of the line. Then, drag and drop these trackers.

4-3. Line Profile Panel

The Line Profile panel displays the cross-sectional height profile of the image along the line created by user. The unit of x axis is usually µm or nm and that of y axis is variable depending on the collected signal to generate its image for example, µm, nm, mV, V and so on. Also, the context menu (see the outlined box in Figure 4-3-1) is generated when you right-click the cursor in the Line Profile panel. These menu items are described below.

![Context menu in the line profile](image)

Figure 4-3-1. Context menu in the line profile
4-3-1 Export

Through the ‘Export’ command in the context menu of Line view, you can export the data of the Line Profile as a text file and save it individually. This text file can be used for analysis in other software program.

4-3-2 Insert (Delete) a Cursor Pair

To measure an exact height difference and distance between two data points in the Line profile, you can insert a cursor pair on the Line Profile by selecting ‘Insert a Cursor Pair’ command in the context menu. You can insert up to three cursor pairs per profile.

When the cursor pair is inserted, two triangular shaped cursors appear on two arbitrary points on the Line profile and the corresponding points on the image in the image display panel as well. Along with the cursor pair, following information is displayed. (see Figure 4-3-2)

- The coordinates of two points marked by cursor
- Height, and distance between the two points marked by cursor
- Slope of the straight line connecting the two points marked by cursor

![Figure 4-3-2. Cursor pair and displayed information](image)

You can adjust the location of the cursors by dragging and dropping individual triangular cursors either from line profile or from the image in the image display panel. The information displayed with the cursor are automatically updated whenever you change the position of the cursor pair. Figure 4-3-3 shows example of using cursor pair.
Figure 4-3-3. Adjust the location of the cursor pair

To delete the cursor pair from the line profile, select ‘Delete a cursor pair’ command from the context menu. This command deletes the most recently added cursor pair from the Line Profile. To delete all the cursor pair from the Line Profile, select ‘Delete all cursor pairs’ command from the context menu.

4-3-3 Slope & Coordinates

You can hide the slope and coordinates from the displayed cursor pair by deselecting ‘Slope’ and ‘Coordinates’ from the context menu.
When you select a line in an image, its power spectrum is displayed in the Power Spectrum panel. Figure 4-4-1 shows the power spectrum of the selected line in the Line view. A power spectrum shows the contribution of each spatial frequency to the line profile versus frequency. It is generally used to examine spatial periodicities in an image and to measure noise characteristics. When you select a line in an image, a power spectrum is automatically displayed.

The Power Spectrum, shown below, is related to the 1-dimensional Fourier transformation of the selected line in the Line Profile. In a Power Spectrum, peaks represent the intensities of frequency components in the selected line. The x axis is the frequency of the selected line and its unit is 1/µm. The y axis is the intensity of the frequency component and its unit can be Å×µm, µm×µm, V×µm and so on. The front unit is varied by on the unit of the selected input signal and z scale within the selected line and the next unit is varied by the length of the line.
4-5. Line Histogram Panel

The Line Histogram shown below (Figure 4-5-1) is a bar graph that shows the distribution of heights along a height profile. When you select a line in an image, a line histogram is automatically displayed.

The x axis is the height of the data points in the sample surface and its unit can be Å, nm, µm and so on. It can display the entire range of height of the data points in a line. The width of a bar depends on the overall height range of the sample and the number of data points of the line profile. The y axis is the number of data points with the same height values and its unit is pixel.

4-6. Line Statistics Table

The Line Statistics table, shown in Figure 4-6-1, shows several statistics of the line profile. Each line is related to one row of the table. The results of the statistics on the selected line are updated automatically when you move the selected line to
different locations in an image. This table can be exported as a text file or image file through ‘Export’ command in the context menu that appears when you right click the mouse with the pointer on the table. Also, you can select the line profile parameters to be displayed on the table from the ‘Show Item’ command in the context menu as well.

<table>
<thead>
<tr>
<th>Statistics</th>
<th>Line</th>
<th>Min(μm)</th>
<th>Max(μm)</th>
<th>Min(%)</th>
<th>Mean(%)</th>
<th>Rp(μm)</th>
<th>Rp(%)</th>
<th>Ra(μm)</th>
<th>Ra(%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>198.384</td>
<td>2.297</td>
<td>1.202</td>
<td>1.147</td>
<td>2.011</td>
<td>793.968</td>
<td>733.738</td>
<td>107.964</td>
<td>56.827</td>
</tr>
<tr>
<td>Green</td>
<td>92.928</td>
<td>2.338</td>
<td>1.216</td>
<td>1.193</td>
<td>2.246</td>
<td>554.799</td>
<td>468.492</td>
<td>45.554</td>
<td>195.960</td>
</tr>
<tr>
<td>Blue</td>
<td>300.751</td>
<td>2.374</td>
<td>1.338</td>
<td>1.291</td>
<td>2.074</td>
<td>805.358</td>
<td>747.477</td>
<td>107.964</td>
<td>56.827</td>
</tr>
</tbody>
</table>

**Figure 4-6-1. Line statistics table**

The meanings of the surface profile parameters displayed in the Line Statistics Table are defined as follows:

- **Min**
  
  Min is the minimum height of the line profile.

- **Max**
  
  Max is the maximum height of the line profile.

- **Mid**
  
  Mid is the average between the minimum and maximum height within the selected line. That is the ‘Mid’ height is, \((\text{Min} + \text{Max}) / 2\).

- **Mean**
  
  Mean is the mean height of the line. It is the sum of the height of each point divided by the number of points.

- **Rpv**
  
  Rpv is the peak-to-valley of the line. It is the difference between minimum and maximum, that is, \((\text{Max} - \text{Min})\).
Rq

Rq is the root-mean-squared roughness. It is the standard deviation of the height value in the selected line.

Ra

Ra is the roughness average.

Rz

Rz is the ten point average roughness. It is the arithmetic average of the five highest peaks and five lowest valleys in the line.

Rsk

Rsk is the skewness of the line.

Rku

Rku is the kurtosis of the line. It indicates the “spikiness” of the sample surface along that line.
Chapter 5. Region View

In the Region view, you can measure and analyze surface regions of an image. You can make quantitative measurements of surface features in the selected regions and collect surface statistics such as surface roughness, average height. These statistical values are displayed in the table and plotted in the Region Histogram panels. Up to three particular regions can be selected to include regions for analysis. Furthermore, you can select regions to exclude certain features from analysis.

In general, you can go through the following steps in Region view:

1. Load an image you want to analyze into the Analysis view from the Navigator view.
2. Enable the Region view.
3. Select regions of the image to include or exclude for Region view.
4. Once selecting region group, both the region histogram plot and statistics table are generated with results and updated whenever the change of the selected region group occurs.
5. Save and print your Region view results

Figure 5-1 shows the summarized procedure to analyze the region of an image.
Figure 5-1. Procedure for Region view
5-1. Layout

To enable the Region view, select ‘Analysis>Region’ menu or click the Region analysis tab below the Toolbar. The Region view consists of the Palette Panel, Image Display Panel, Region Selection Toolbar, Region Histogram Panel, Histogram and the Statistics table. Figure 5-1-1 shows the Region view that is divided into several parts.

![Figure 5-1-1. Region view](image)

5-1-1 Palette Panel, Image Display Panel and Histogram

Just as in other Analysis views, the image you want to analyze can be displayed in the Image display panel with the Palette Panel. It is the same Palette Panel and Image Display Panel that appears in all the analysis views of XEI. Please refer to Chapter 3-2 and 3-3 for details.

Also the histogram of the entire image surface is displayed on the bottom of the Image Display Panel as in the other analysis views. However, Histogram in the Region View has special ‘Height Restriction Markers’ to select pixels within certain height range. Detailed features of the Region Selection Toolbar are explained in
section 5-3.

5-1-2 Region Selection toolbar

Region selection toolbar, where the Tools for selecting region for the analysis are gathered, is at the right side of the image Display Panel.

5-1-3 Region Histogram Panel

Three Region Histograms, corresponding to three different user-selected Region groups (Red, Green and Blue), are generated automatically at the right side of the Image display panel. Detailed features of the Region Histogram Panel are explained in section 5-4.

5-1-4 Region Statistics Table

In the Region View, below the Image display panel, the Region Statistics table will be generated. Detailed features of the Region Statistics Table are explained in section 5-5.

5-2 Selecting Region for Region Analysis

To get reasonable information of surface statistics, it is important to select specific regions including or excluding the data for analysis. Region selection toolbar contains various tools that help you to select precise region for region data analysis. The process of selecting region for analysis is done in four steps.

Step 1. Select Region Group

Region Group is the group of the ‘selected area’ for the region statistical analysis. Each region group is made of single or multiple ‘selected area’. XEI allows user to create and edit up to three Region Groups, Red, Green and Blue for region analysis. The ‘selected area’ that belong to different Region Groups are discriminated by their color. Before you create or edit ‘selected area’ on the image for the region analysis, you should decide to which region group the ‘selected area’
will belong by clicking one of the Region Group Select button.

![Region Group Diagram](image)

*Figure 5-2-1. Region Group*

**Step 2. Select Inclusion or Exclusion**

You should decide whether the pixels within the ‘selected area’ you create to be included or excluded by clicking either Inclusion or Exclusion before you create a ‘selected area’. Figure 5-2-2 shows effect of selecting Inclusion and Exclusion on region analysis result. Be aware that the selecting area as ‘Exclusion’ is effective only if the area selected as ‘Exclusion’ is part of the area that has been selected as ‘Inclusion’.

![Inclusion and Exclusion Diagram](image)

*Pixels within red rectangle is included in the region analysis. Notice the two separate distribution (a and b) in the histogram owing to the two different features (A and B) in the selected region with different height.*
Figure 5-2-2. Region view

Step 3. Create ‘selected area’

You can create ‘selected area’ of different shapes by using Rectangle, Ellipse and Polygon button. Also you can designate entire image as a ‘selected area’. ‘Selected area’ for Inclusion will be painted in red, green, and blue while the ‘Selected area’ for Exclusion will be only outlined in red, green and blue depending on the color of the region group to which selected area’ belongs to.

- **Rectangle & Ellipse**

To create rectangle or ellipse shaped ‘selected area’, click the ‘Rectangle’ or ‘Ellipse’ button, respectively. Then, press the cursor at the point you want to create the top-left corner of a ‘selected area’, and drag the mouse pointer at the point you want to create bottom-right corner of a ‘selected area’.

- **Polygon**

To create polygon shaped ‘selected area’, click the polygon button and click the cursor onto the point you want to create a starting point of a polygon. Move and click the cursor at each point of the polygon region. Double-click at the point you would like to make the end point.

- **Entire Region**

To set the entire image as ‘selected area’, click the ‘Entire Region’ button.
Step 4. Edit the ‘selected area’

You can move, delete and resize the ‘selected area’ created in step 3 with the help of the ‘Move tool’. Move tool only appears on the toolbar only if you have checked ‘region’ check box from the ‘Use Move Tool’ option in the ‘Preferences Window’.

When the ‘Use Move Tool’ option for the ‘region’ is checked, mouse pointer stays in ‘region selection’ (cross hair mouse pointer) mode so that user can continuously create ‘selected area’ for region analysis one after another. Mouse pointer will stay in ‘region selection’ mode unless you click ‘Move Tool’ button to exit ‘region selection’ (cross hair mouse pointer) mode and switch to ‘region edition’ (arrow mouse pointer) mode. On the other hand, when the ‘Use Move Tool’ option for the ‘Region’ is not checked, the mouse pointer will automatically switch from ‘region selection’ (cross hair) to ‘region edition’ (arrow) mode each time you create a line.

■ Selecting

First, select the region group (R, G, B) corresponding to the region shape you would like to edit. Next, click ‘Move tool’ to enable the region shape edit. Click on the region shape you would like to move to select it. You can also select multiple region shape by pressing ‘Ctrl’ key as you click multiple region shape. To select all the region shape of the region group, press Ctrl+A or select ‘Select All’ in the context menu.

■ Moving

The mouse cursor changes to four arrow cursor and selected region shape is marked by circular tracker around it. You can move the selected region by dragging it.

■ Deleting

To delete the selected region shape, select delete command from the context menu or press delete button.

■ Changing Shape

In case of rectangle and ellipse, you can also extend or shrink the selected region by dragging a small circular tracker that appears when you click the region.
You can also rotate a rectangle and ellipse by dragging a green circular tracker. In case of polygon, you can change the shape of the already made polygonal region by dragging each circular tracker of it. However, the number of points cannot be changed.

5-3. Height Restriction Markers

Below the Image display panel, histogram of the loaded image is displayed. Height restriction markers are two flags that appear when the Region Histogram is displayed. Height Restriction Markers are used to exclude the pixels within certain height range from the region analysis.

There are two Height Restriction Markers, Lower and Upper. Drag these two ‘Height restriction Markers’ on the each side of the histogram to set the lower and upper value of the pixels to be selected. Pixels with the height lower than the ‘Lower Height restriction Marker’ or higher than the ‘Upper Height restriction Marker’ will be excluded from the region analysis. Pixels that are excluded from the analysis are marked in violet color at Palette bar.

![Figure 5-3-1. Region view](image)

5-4. Region Histogram Panel

The Region Histogram panel provides information about the distribution of
heights of the pixels within the selected region. Corresponding to the three selectable region groups, up to three Region Histograms (R, G, B) can be generated.

Figure 5-4-1 shows the Region Histogram panel. The x axis represents the height of data points in the sample. The y axis represents the number of pixels (or bearing ratio) in the selected region group. Several features that help user to perform further analysis of the Region Histogram can be accessed through the context menu.

**Figure 5-4-1. Region histogram panel**

**5-4-1 Export**

Through the ‘Export’ command in the context menu of Line view, you can export the data of the Region Histogram as a text file and save it individually. This text file can be used for analysis in other software program.
5-4-2 Bearing Ratio

Bearing ratio at arbitrary representative value in histogram is defined as follows.

Bearing ratio

\[ = 100\% - \text{percentage of the pixels whose values are below the current representative value.} \]

In default display, the y axis of the Region Histogram panel represents the number of pixels in the selected region group. User can choose to display ‘Bearing Ratio’ instead of the number of pixels by selecting ‘Bearing Ratio’ command in the context menu.

![Figure 5-4-2. Bearing Ratio display](image)

5-4-3 Insert (Delete) a Cursor Pair

Cursor pair can be inserted into a Region Histogram as it can be done in the
Line Profile Panel (See section 4-3-2) to measure a difference between the number of pixels (or bearing ratio) and the representative value of two columns in the histogram. You can insert a cursor pair on the Line Profile by selecting ‘Insert a Cursor Pair’ command in the context menu. You can insert up to three cursor pairs per profile. Figure 5-4-3 shows a cursor pair inserted in the Region Histogram.

When the cursor pair is inserted, two triangular shaped cursors appear on two arbitrary columns on the Region Histogram. Along with the cursor pair, additional information is displayed (Figure 5-4-3).

![Figure 5-4-3. Cursor pair and displayed information](image)

You can adjust the location of the cursors by dragging and dropping individual triangular cursors either from Region Histogram. The information displayed with the cursor are automatically updated whenever you change the position of the cursor pair.

To delete the cursor pair from the Region Histogram, select ‘Delete a cursor pair’ command from the context menu. This command deletes the most recently added cursor pair from the Region Histogram. To delete all the cursor pair from the Region Histogram, select ‘Delete all cursor pairs’ command from the context menu.
5-5. Region Statistics Table

The Region Statistics table, shown in Figure 5-5-1, displays the statistics of the all data points in the selected region group. Each region group is related to one row of the table. The results of the statistics on the selected region are updated automatically when you change the selected region group by resizing or moving the region selector. This table can be exported as a text file or image file through ‘Export’ command in the context menu that appears when you right click the mouse with the pointer on the table. Also, you can select the line profile parameters to be displayed on the table from the ‘Show Item’ command in the context menu as well.

![Figure 5-5-1. Line statistics table](image)

The meanings of the surface profile parameters displayed in the Line Statistics Table are defined as follows: (for detailed definition and physical meaning of these parameters, please refer to the Appendix.)

- **Min**
  
  Min is the minimum height of the line profile.

- **Max**
  
  Max is the maximum height of the line profile.

- **Mid**
  
  Mid is the average between the minimum and maximum height within the selected line. That is the ‘Mid’ height is, \( (\text{Min} + \text{Max}) / 2 \).

- **Mean**
  
  Mean is the mean height of the line. It is the sum of the height of each point divided by the number of points.
■ **Rpv**

Rpv is the peak-to-valley of the line. It is the difference between minimum and maximum, that is, (Max – Min).

■ **Rq**

Rq is the root-mean-squared roughness. It is the standard deviation of the height value in the selected line.

■ **Ra**

Ra is the roughness average.

■ **Rz**

Rz is the ten point average roughness. It is the arithmetic average of the five highest peaks and five lowest valleys in the line.

■ **Rsk**

Rsk is the skewness of the line.

■ **Rku**

Rku is the kurtosis of the line. It indicates the “spikiness” of the sample surface along that line.
Chapter 6. Grain View

In the ‘Grain View’ user can perform grain analysis on the loaded image. System automatically

1. Detects grains in the image
2. Marks each detected grain with different colors and numbers
3. Calculates important surface profile parameters of each detected grain and displays them in table,
4. Displays Distribution of surface parameters among detected grains will be displayed in the histograms.

Basically, you can perform grain analysis on the loaded image through the following procedure.

1. Bring an image file into the Analysis view from the Navigator view.
2. Enable the Grain View and select between two grain detection methods, Threshold or Watershed.
3. Set appropriate parameters for the selected grain detection method (Threshold: Range, Watershed: Filter level). Run the automatic grain detection process.
4. Each detected grain will be marked with different colors and numbers on the loaded image. Surface profile parameter of each detected grain will be displayed in the table. Distribution of surface parameters among detected grains will be displayed in the histograms. Export table, image and histogram as image or text file if desired.
6-1. Grain Detection Method

User can select between two different grain detection methods to use for automatic grain detection process. These two detection methods are ‘Threshold’ and ‘Watershed’.

6-1-1 Threshold method

Algorithm

In the algorithm of ‘Threshold’ grain detection method, group of pixels surrounded by the other pixels whose values are larger (or smaller) than the upper (or lower) ‘Threshold’ value are recognized as grain. Figure 6-1-1 shows a simplified 1D example showing how ‘Threshold grain detection algorithm” works.

As can be seen from Figure 6-1-1, grain detection result differs according to the range setting and threshold value setting. XEI allows users to select between ‘lower’ and ‘upper’ for range and set the value of threshold by moving ‘Height restriction marker’ in the histogram of loaded image.

Upper

When the range is set to ‘Upper’, the ‘Height restriction marker’ appears on the left side of the histogram. User can set the ‘upper threshold value’ by moving the ‘height restriction marker’. The pixels corresponding to the left side of the upper threshold markers are colored in purple to indicate their values are smaller than the
threshold value selected by the marker. Group of pixels surrounded by the other pixels whose values are smaller than the ‘Threshold’ value (i.e. pixels that are not colored in purple) are recognized as grain.

- **Lower**

  When the range is set to ‘Lower’, the ‘Height restriction marker’ appears on the right side of the histogram. User can set the ‘lower threshold value’ by moving the ‘height restriction marker’. The pixels corresponding to the right side of the lower threshold markers are colored in purple to indicate their values are larger than the threshold value selected by the marker. Group of pixels surrounded by the other pixels whose values are larger than the ‘Threshold’ value (i.e. pixels that are not colored in purple) are recognized as grain. Figure 6-1-2 shows the example of ‘Threshold’ grain detection process.

![Figure 6-1-2. Threshold Grain Detection Process](image)

**6-1-2 Watershed method**

- **Algorithm**

  To understand the algorithm of ‘Watershed’ grain detection method, let’s look at the 1D example in the Figure 6-1-3.

  Now, let’s imagine that we pour water over this surface. Water will first fill the lowest point of the surface. The region that water starts to fill in is recognized as a single grain. As the level of water increases, water starts to fill more region of the surface and thus more grains are detected. Then when the level of water
reaches certain value, water filling one grain will start to overflow to other neighboring grains. Algorithm recognizes this point and sets the grain boundary.

Figure 6-1-3. Watershed Grain Detection Process

- **Parameter settings in ‘Watershed’ grain detection**

  As it can be expected from the algorithm of the ‘Watershed’ grain detection method, surface roughness affects the number of detected grains, or the ‘sensitivity’ in the watershed grain detection method. See Figure 6-1-4. In some cases, ripples in the images can be detected as a grain via watershed algorithm, resulting in a single grain to be divided into many ‘unwanted’ grains.
To control the surface roughness and thus the detection sensitivity of the method, it is desirable to apply ‘smoothing’ filter to the image before the detection algorithm starts. ‘Filter level’ parameter is the level of filter that is applied to the image before the ‘Watershed’ grain detection starts. The higher the filter level, the more the image will be smoothed before grain detection to remove ‘grains’ created by noise. Filter level acts to control the sensitivity of the grain detection as shown in Figure 6-1-5. Notice the difference in the number of total detected grain displayed in right corner and how the grains circled in dotted line differ according to the filter level.
6-2. Grain Display Panel

When the grain detection process is complete, XEI will mark each detected grain with a different color and number. The number for each grain is allocated in the order that it was detected. The color of each grain is randomly generated from XEI in order to prevent any grains being marked with the same color. (Each colored grain is best seen if you view the original image in ‘Gray scale’.)

6-2-1 Selecting and deleting the detected grains

Each detected grain can be selected and deleted. This function is useful for picking out the ‘unwanted’ grains. Just click on any detected grain to select it. Then the boundaries of selected grains will be dotted with white circles. To delete the selected grains press ‘Delete’ button. You can also select multiple grains. There are two ways.

1. Hold down ‘Ctrl’ button of your keyboard as you click multiple grains.
2. Click and drag to select grains in the region of your interest (Figure 6-2-1).

To select all the detected grains in the loaded image, click anywhere on the image and then press ‘Ctrl+A’ or select ‘Select All’ from the context menu which appears when you right-click on the image (Figure 6-2-1).

![Figure 6-2-1. Multiple grain selection](image.png)
6-2-2. Show Number and Restore Grain Button

- **Restore Grain Button**

  Click this button to restore the deleted grains by reloading the initially detected grains.

- **Show Number Button**

  Click this button to display or hide the numbered label on each detected grains.

![Show All and Show Valley](image)

**Figure 6-2-2. Show All and Show Valley**

- **Show All (only in watershed mode)**

  Clicking this button displays all the grains detected by ‘watershed’ grain detection method.

- **Show Hills Only (only in watershed mode)**

  Clicking this button displays only the ‘hills’ among the grains detected by ‘watershed’ grain detection method. In the algorithm of the ‘watershed’ grain detection, hills are defined as a grain whose average value of the pixels within exceeds the average of the pixels on the boundary.

- **Show Valleys Only (only in watershed mode)**

  Clicking this button displays only the ‘valleys’ among the grains detected by ‘watershed’ grain detection method.
valleys are defined as a grain whose average value of the pixels within does not exceed the average of the pixels on the boundary.

6-3. Statistics Table

After automatic grain detection, XEI calculates important surface profile parameters of each detected grain. These parameters are displayed in the statistic table. The meanings of the parameters are given in the table below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area</td>
<td>Area is the projected area of the detected grain.</td>
</tr>
<tr>
<td>Volume</td>
<td>Volume is the volume of the detected grain.</td>
</tr>
<tr>
<td>Length</td>
<td>Length is the distance between the two farthest points within the projected area of the grain.</td>
</tr>
<tr>
<td>Peri</td>
<td>Peri is the perimeter of the projected area.</td>
</tr>
<tr>
<td>Min</td>
<td>Min is the value of the smallest value within the grain.</td>
</tr>
<tr>
<td>Mean</td>
<td>Mean is the mean height of the region. It is an average height within the included areas defined by a region group.</td>
</tr>
<tr>
<td>Rpv</td>
<td>Rpv is the peak-to-valley of the region. It is the difference between the minimum and maximum height, that is, (Max – Min).</td>
</tr>
</tbody>
</table>

In the ‘Statistic Table’, the surface profile parameters of the detected grains are arranged in numerical order. If more than 20 grains are detected system will display 20 grains at each page. You can jump from pages to pages through the arrow at the bottom right of the table. When the user selects grains from the image, surface profile parameters of the selected grains are displayed in the top of the table in bold letter. Moreover, when multiple grains are selected, mean value and standard deviation of each parameter are displayed in Mean and Std row. Table can be exported as a table or text file. Also parameters to be displayed can be selected from context menu.
6-4. Histogram Panel

The distribution of the certain surface profile parameters related to the grain size analysis, (i.e. area, volume, surface, perimeter) is plotted as a histogram in the histogram panel.
Chapter 7. PSD View

In the ‘PSD View’ user can view PSD graph of the loaded image and obtain relevant data. PSD view is useful for surface roughness analysis.

Figure 7-1. PSD View

7-1. What is PSD?

PSD is an abbreviation of “Power Spectrum Density.” PSD of the loaded image is obtained from Fourier Transform (FT) of the image and reflects the RMS roughness of the sample surface. PSD, FT, and RMS roughness are related as follows.

\[ \text{PSD} = \text{FT}^2 = \text{RMS}^2 \]
The power spectral density (PSD) of a surface is equal to square of its Fourier Transform (FT) and RMS roughness value squared.

### 7-1-1 Meaning of PSD

PSD is one of many parameters that are used to represent the surface roughness of the sample. PSD has advantages over the other surface roughness parameters such as RMS roughness because PSD contains the information how each frequency component contributes to the total roughness of the surface.

The example below shows the advantage of PSD as a surface roughness parameter. The images ‘sinepi.tif’ and ‘sine2pi.tif’ in Figure 7-1-1a are synthetic images generated from two sine functions with same amplitude but different frequency.

---

**Figure 7-1-1a. Two synthetic images of same roughness**
As a result, their roughness parameters (Rpv, Rq, Ra, Rz, Rsk, Rku) are same despite eminent differences between their surface profile. These images are also included in sample image folder of XEI (C:\Program Files\PSIA\XEI\samples). Load these images to ‘Region’ view and check their roughness by yourself.

However, PSD graph which contains not only roughness information but also the contribution of each frequency components to the roughness can discriminate the difference of roughness between two images.

**2D PSD of ‘sinepi.tif’**

![2D PSD of ‘sinepi.tif’](image)

**2D PSD of ‘sine2pi.tif’**

![2D PSD of ‘sine2pi.tif’](image)

Figure 7-1-1b. PSD of two synthetic images of same roughness

### 7-2. **PSD Graphs**

XEI calculates and plots three different types of PSD for the loaded image; PSD X, PSD Y and PSD 2D. The X axis of the PSD X and PSD Y graph is the ‘spatial frequency (cycle/µm)’ of the image. For PSD 2D graph, the unit of the ‘spatial frequency’ is different (cycle/µm²) as the range of power spectrum is 2 dimensional area.

The Y axis of the PSD graph is ‘Power Spectrum Density’, which is Power
spectrum (µm²) corresponding to each spatial spectrum (cycle/µm) value. Thus the unit for the Power Spectrum Density is \( \mu m^2 / (cycle/\mu m) = \mu m^3 \).

For each PSD graphs, there are two cursors (cursor 1 and 2) that slides along the X axis to mark point of interest on the PSD graph.

### 7-2-1 PSD 2D

PSD 2D graph is generated from 2 dimensional Power spectrum of the image. Power corresponding to the area of same ‘spatial frequency’ (represented as concentric circle in 2D power spectrum of the image)

![Figure 7-2-1a. PSD 2D](image)

### 7-2-2 PSD X(Y)

PSD X(Y) is an average of the power spectrums for each line of the image parallel to X(Y) axis

![Figure 7-2-1b. PSD X axis](image)
7-2-3 PSD Export

PSD graphs can be exported to 'text' file for further analysis through other data processing software.

7-3 PSD Statistics Histogram

Various statistical analysis results of the PSD graph is displayed in this Histogram Panel.
**Figure 7-3-1. PSD Statistics & Histogram**

- **F1(2)**
  
  Spatial frequency of the cursor 1(2)'s position

- **PSD1(2)**
  
  Power Spectrum Density at the cursor 1(2)'s position

- **P12**
  
  Area under the graph bounded by the cursor 1 and 2.

- **Rq12**
  
  RMS roughness between the cursor 1 and 2. Square root of the P12.

- **P**
  
  Total area under the graph

- **Rq**
  
  Total RMS roughness of the image Square root of the P.
Chapter 8.  3D View

In the 3D view, you can see both the features of the image and the relationships between those features in a 3D rendered view. Different from other microscopic techniques such as SEM or TEM, the 3D view is unique to SPM. The scanning probe microscope scans the sample surface horizontally (x, y) line by line while collecting the vertical (z) direction profile of the sample surface. As a result, the scanning probe microscope collects truly 3-dimensional (x, y, z) information from the surface and this 3-dimensional data represents true surface topography.

Basically, you can create the 3-dimensional perspective of an image through the following procedure.

1. Bring an image file into the Analysis view from the Navigator view.
2. Enable the 3D view to generate an initial 3D rendering of the image.
3. Adjust several 3D rendering parameters to obtain the best 3D view
4. Export and print out the 3D image if desired.

Figure 8-1 shows the summarized procedure for 3D rendering of an image.
8-I. 3D View

To open the 3D view, select the ‘Analysis>3D’ menu or click the 3D view tab below the Menu bar.

The 3D view consists of two main regions (see Figure 8-1-1): One is the 3D Image display panel that is placed to the left side in the Analysis view. The other is the 3D rendering parameters panel to the right side. These are going to be described in detail in the next section.

In the 3D view, you can change the following characteristics of the image:

- The presented resolution of the image
- The rotation angle of the image
- The size of the image
- The height magnification
- The position of the simulated light source
The color and intensity of the simulated light source

The color of the image and background

8-2. 3D Image Display Panel

In the 3D Image display panel, the 3-dimensional perspective of an image is displayed and updated immediately after you adjust anything of the available 3D rendering parameters. The 3D image is held within a frame and presented on a virtual plane. Dragging the cursor within the frame allows you to rotate the image in the 3D Image display panel.

Using the 3-dimensional (x, y, z) data set, the individual lines will be stacked to generate the 3-dimensional perspective and then this view may be adjusted by simulating the reflection of light from the surface. Surface features that would be illuminated from above appear bright, and features that would be illuminated from an oblique view appear dark. You can vary the direction of illumination by changing the position of an artificial light source. You can also rotate the image to vary your viewing angle. Figure 8-2-1 shows the general 3D Image display panel
The 3D rendering parameters can be adjusted to get the best 3-dimensional view of the sample surface. Whenever you adjust these parameters, they are automatically applied to the 3-dimensional image in the 3D Image display panel. These 3D rendering parameters, as shown in Figure 8-3-1, are described further below.

Figure 8-2-1. 3D Image display panel

8-3. 3D Rendering Parameters

The 3D rendering parameters can be adjusted to get the best 3-dimmensional view of the sample surface. Whenever you adjust these parameters, they are automatically applied to the 3-dimensional image in the 3D Image display panel. These 3D rendering parameters, as shown in Figure 8-3-1, are described further below.
8-3-1. Resolution

Allows you to vary the resolution of the displayed 3D image. You can select the number of sampling data points in the Sampling combo box. By default, the image pixel size is set to be 256×256. So the number of sampling data points is automatically changed to be displayed at this default resolution. However, when the pixel size of the original image is more than 256×256 (512, 1024, 2048, and 4096), you can enhance the resolution of the 3D view by selecting the appropriate sampling number (1, 2, 4, or 8; see Figure 8-3-2). However, increment of the image pixel size is less effective since this may need larger memory but cannot show remarkable enhancement of the image's resolution.
Sampling Number

Changes the number of sampling data points in the line. Sampling number is automatically set to as follows: the number of data points ÷ sampling number = 256.

Sometimes the number of data points collected for a line exceeds the number of pixels on the 3D Image display panel. In this case, you should select the reasonable sampling number (see Figure 8-3-2) to enhance the resolution of the 3D displayed image. When you open a new image, the sampling is selected automatically to display 256 data points for a line. To adjust the display for higher resolution images, you should set the sampling numbers manually. For example, when the pixel size of the original image is 1024, the sampling number is automatically converted to 4 (in order to reduce its pixel size to 256×256 1024 should be divided by 4), but you can enhance the resolution of the 3D image by selecting a smaller number for sampling the data (when the number is 1 or 2, the image pixel size is 1024 or 512).
8-3-2. Transform

Allows you to alter the viewing angle and the scale of the 3D image. Also, you can translate the 3D rendered image in the z direction. Figure 8-3-3 shows the 3D image view that the Transform functions are applied to the 3D rendition of an image.

Figure 8-3-3. Transformed 3D image
Rotation

Changes the viewing angle of the image by rotating the 3D image. You can rotate the image plane around the x, y and z axis by entering the rotation degrees or by using the spin buttons next to the Rotation text fields for X, Y and Z respectively. You can change the viewing angle from -180 to 180 in x, y and z direction.

- X: changes the viewing angle of the image in the x direction
- Y: changes the viewing angle of the image in the y direction
- Z: changes the viewing angle of the image in the z direction

Scale

You can alter the scale of the 3D rendered image in the horizontal (x, y) and the vertical (z) directions. The ‘Isotropic Z scale’ check box fits the z scale to the maximum scale of x, y. Consequently, you will see an image that is similar to the real surface.

- X: alters the scale of the 3D image in the x direction
- Y: alters the scale of the 3D image in the y direction
- Z: alters the scale of the 3D image in the z direction

Translation

When the height profile of the 3D image is too large, you can change the position of the 3D image in z direction. Since the room for displaying 3D image is restricted, it is desirable not to translate its position in x and y direction.
8-3-3. Light

Changes the position of the simulated light source. By default, an ‘Ambient Light’ is turned on when you enable the 3D view. The ‘Ambient Light’ is the default light that commonly exists everywhere, similar to sunlight. It is used to minimize the variation of light effects among various shaped images.

In addition to an ambient light, there is another light source that may be adjusted by the user. You can change the position of the light source by specifying the position in x, y, and z direction.

■ Position

- X: moves the position of the simulated light source in the x direction
- Y: moves the position of the simulated light source in the y direction
- Z: moves the position of the simulated light source in the z direction

■ Luminosity

You can increase or decrease the luminosity of a 3D rendered image by adjusting the slider from Low to High.

■ Reflexibility

You can increase or decrease the reflexivity of a 3D rendered image by adjusting the slider from Low to High.

■ Enable Ambient Light

You can turn on or off the ‘Ambient light’ by selecting or deselecting it in the ‘Ambient light’ check box, respectively.
8-3-4. Option

- **Enable Perspective**

  Enables the perspective 3D display. Figure 8-3-4 shows two images selected (above) and deselected (below) the ‘Enable Perspective’ option in the 3D view.

![Figure 8-3-4. Enable Perspective](image)
- **Show Wire Frame**

  Shows the wire frame display of the image. Figure 8-3-5 shows two images deselected (above) and selected (below) the ‘Show Wire Frame’ option in the 3D view.

![Figure 8-3-5. Show Wire Frame](image-url)
Show XY Axis

Shows the X and Y axes. Figure 8-3-6 shows two images selected (above) and deselected (below) the ‘Show XY Axis’ option in the 3D view.

Figure 8-3-6. Show XY Axis
### Show Z Axis

Shows the Z axis. Figure 8-3-7 shows two images selected (above) and deselected (below) the ‘Show Z Axis’ option in the 3D view.

![Figure 8-3-7. Show Z Axis](image-url)
Fill Border

Fills the border of the image. Figure 8-3-8 shows two images selected (above) and deselected (below) the ‘Fill Border’ option in the 3D view.

Figure 8-3-8. Fill Border
### Show Plane

Shows the visual plane at the bottom of the image. Figure 8-3-9 shows two images deselected (above) and selected (below) the ‘Show Plane’ option in the 3D view.

![Figure 8-3-9. Show Plane](image)

8-3-5. Restore Defaults

Restores parameter values to the original default settings provided with the software. Figure 8-3-10 shows two images before (above) and after (below) click the 'Restore Defaults' button in the 3D view.

Figure 8-3-10. Restore Defaults
Chapter 9. Multi View

In the Multi view, you can display and export or print out several images simultaneously. All images will include a file name and a palette panel indicating the contrast level and data range. Up to 6 images can be displayed at once for a multi image report. You can arrange several images in the Multi view using the following procedure:

1. Load multiple images into the Navigator view from your image directory.
2. Enable the Multi view.
3. Drag and drop images from the Navigator view to the Multi view.
4. Individually adjust the contrast level and range using the palette panel of the selected image.
5. Print and Export the multi images if desired

Figure 9-1 shows the procedure to generate multi images report in the Multi view.
Figure 9-1. Procedure to generate multi images
9-1. Multi View

To enable the Multi view, select the ‘Analysis>Multi’ in the Menu or click the Multi tab below the menu bar.

You can display up to 6 images at once in the Multi view. When you want to eliminate displayed images from the Multi view, click the ‘Clear’ button that is positioned at the bottom of the Multi view.

Figure 9-1-1 shows the Multi view which shows the initial screen, two images loaded view, four imaged loaded view and six images loaded view. You can see that as the images are added into the multi view, their size become smaller.

![Figure 9-1-1. Multi View with different numbers of images loaded.]

9-2. Bring Images into the Multi View

It is simple for you to bring images for Multi view. Only you have to do is to drag and drop images from the Navigator view into the Multi view (see Figure 9-1). One image can be loaded into the Multi view at one time. Up to 6 images can be loaded into the Multi view. The more images in the Multi view, the smaller size of the images. If you want to delete some images, select the images and click the ‘Delete’ button. If you want to delete all images, click the ‘Delete All’ button.
9-3. Adjust the Contrast Level and Range

You can adjust the contrast range and level using the individual palette panel for each image in the Multi view. How to adjust the contrast level or range is like that of other analysis views. Consult section 3-2. Palette Panel, for more information about changing the contrast range and level.
Chapter 10. Crop

In the Crop process, you can select several parts of an image that you are interested in. The Crop processing tool allows you to eliminate “bad data” from an image file, thus making it easier to selectively process the true or reliable data in the same file.

10-1. Crop Process Dialog

To open the Crop process dialog, select ‘Process>Crop’ in the Menu or click the ‘Crop’ icon in the Toolbar. As shown in Figure 10-1-1, the Crop process dialog is composed of two panels, the Image display panel and the Zoom Image display panel.

In the Image display panel, the left side of the Crop Process dialog, you will see a red outlined square, crop square in the image. You can use this square to select the region you would like to crop. You can control the size of the region to be cropped and move it to the desired area. To magnify and reduce the selected region, drag and drop the cursor which is generated at any of the square’s four corners. Also, to move the square, drag and drop the four-arrow cursor that appears when the cursor is positioned within the square.

At the right side of the Crop process dialog, there is the Zoomed Image display panel which shows the enlarged image of the selected region (red bordered box in the image). You can preview a newly cropped region in this Image display panel.
Figure 10-1-1. Crop process dialog

10-2. Crop an Image

In general, follow these steps to crop an image (see Figure 10-2):

1. Load an image file into the Analysis view from the Navigator view.
2. Select ‘Process>Crop’ or click the ‘Crop’ icon in the Toolbar to display the Crop process dialog.
3. Move the crop square over the region to be cropped. Increase or decrease the size of the selected region as desired.
4. Once you are satisfied with the new area, click the ‘Execute’ and ‘OK’ button to create a newly cropped image that will be generated with a default name of ‘original name+cropped.tiff’ in the Navigator view.
5. Save the cropped image as another file name for further image processing and analysis.
NOTE!

Cropping a local region of an image produces a new, processed image that can be saved to your hard disk or printed. Cropping an image does not affect the original data.

Figure 10-2 shows the procedure to crop an image.

Figure 10-2-1. Procedure to crop an image
This is a blank page.
Chapter 11. Arithmetic Filter

In order to get better presentations and the best measurement results, the Arithmetic Filters are used to reduce various noisy features in the image. The Arithmetic Filter processing techniques in XEI are divided into four classes: Smoothing, Sharpening, Edge Enhancement, and Custom. This chapter describes the functions under each of these four classes.

Most of the filters use an \( n \times m \) filtering kernel matrix, where \( n \) and \( m \) are odd integers so that there is a unique center of the kernel matrix. A filter places this kernel on a matrix of image pixels and uses the values of neighboring pixels to determine the new value for the center pixel.

11-1. Filter Process Dialog

To open the Filter process dialog, select the ‘Process>Filter’ menu or click the ‘Filter’ icon \( \text{\textdaggerblacksymbol} \) in the Toolbar. As shown in Figure 11-1-1, the Filter list box has four groups of filters. Those groups are ‘Smoothing’, ‘Sharpening’, ‘Edge Enhancement’, and ‘Custom’. Each filter group has several different types of filters. After you select the desired filter, set the kernel width and height. The meaning of each item in the Filter process dialog is described in detail below.
11-2. Smoothing

The smoothing processes reduce sharp edges and small variations. This effectively removes glitches and is useful therefore.

11-2-1 Mean

The Mean Filter's characteristics are determined by the kernel height and width. A larger kernel size results in more blurring. Therefore, an excessive kernel size may produce unexpected effects on your data.

After the filter calculates the average of the pixels bounded in the kernel matrix, the average is set to be a new pixel value located at the center of the kernel. If you use a 3 by 5 kernel, for example, this filter places this kernel on an image and then calculates the average of 15 (= 3 × 5) image pixels bounded in the kernel to substitute each pixel value to the average.
Chapter 11. Arithmetic Filter

- **Gaussian Blur**

  The Gaussian Blur Filter’s characteristics are determined by the kernel height and width, and the standard deviation. These can be varied with separate values for the X and Y dimensions. The pixel is set to the center value of the Gaussian curve that best fits the data points.

- **Median**

  The Median filter is an effective method for removing outliers or shot noise in an image. At first, the Median filter sorts the pixel data to find the median of the pixels bounded in the kernel matrix. Then, the median value is used to replace the value of a pixel that is over the acceptable range. If you use a 3 by 5 kernel, for example, this filter places this kernel on an image and calculates the median of 15 (= 3 × 5) image pixels bounded in the kernel. The calculated median is set as a new pixel value located at the center of the kernel.

  The median filtering is more reliable than the average filtering in the cases such as the one in the following example:

  When one value deviates extremely from the others and shifts the mean as in this set “1, 3, 4, 5, 9, 10, 200, 14, 15, 17, 19”, the median is 10 and the average of this set is 297/11=27. If the out of range value is considered to be a bad data point and is then excluded from the calculation of the average, the more accurate average would now be closer to the median: (297-200)/10=9.7.

- **Low Pass**

  The Low Pass filter has a fixed kernel size of 3x3. The value “Weighting Factor” is represented in the kernel by n. The term 1/(n+2)^2 can be factored out, so the kernel can also be represented as the product of (n+2)^2 and the values in the following table.

<table>
<thead>
<tr>
<th>1/(n+2)^2</th>
<th>n/(n+2)^2</th>
<th>1/(n+2)^2</th>
</tr>
</thead>
<tbody>
<tr>
<td>n/(n+2)^2</td>
<td>n^2/(n+2)^2</td>
<td>n/(n+2)^2</td>
</tr>
<tr>
<td>1/(n+2)^2</td>
<td>n/(n+2)^2</td>
<td>1/(n+2)^2</td>
</tr>
<tr>
<td>-----------</td>
<td>----------</td>
<td>-----------</td>
</tr>
<tr>
<td>1</td>
<td>n</td>
<td>1</td>
</tr>
<tr>
<td>n</td>
<td>n^2</td>
<td>n</td>
</tr>
<tr>
<td>1</td>
<td>n</td>
<td>1</td>
</tr>
</tbody>
</table>
**11-3. Sharpening**

Sharpening filters are used to make smaller features more noticeable. They increase the difference between neighboring pixels.

**11-3-1 High Pass**

High Pass is the first of the Sharpening filters. Its kernel size is variable but must be a square. The center pixel is multiplied by the square of the length of the square; all other pixels are given a weight of -1.

**11-3-2 Laplacian of Gaussian**

The Laplacian of Gaussian allows the user to perform both the Gaussian Blur, then the Laplacian Edge Enhancement on an image in one go. However, the X and Y kernel size and standard deviation values for the Gaussian blur are equal.

**11-4. Edge Enhancement**

Edge Enhancement functions create images of the gradient between pixels. This allows the user to better distinguish edges of sample features.

**11-4-1 Roberts**

The Roberts filter can be applied in the four cardinal directions, denoted as “East,” “West,” “North,” and “South.” This filter sets the value of each point as the difference between the point and the point adjacent to it in the direction of application. For example, if one chose East, pixel (5,5,10) with a neighbor (4,5,8) would now have the value of (5,5,10-8). One can also say that the value of a pixel is set to be the sum of itself and its neighbors when they are multiplied by the following kernel (for the East direction):

\[
\begin{array}{ccc}
0 & 0 & 0 \\
-1 & 1 & 0 \\
0 & 0 & 0 \\
\end{array}
\]
Chapter 11. Arithmetic Filter

11-4-2 Sobel

The Sobel filter differs from the Roberts filter in that it weighs the neighboring pixels differently. Instead of finding the difference between the actual pixel and one neighbor, it finds the difference between pixels on opposing sides:

\[
\begin{array}{ccc}
-1 & 0 & 1 \\
-2 & 0 & 2 \\
-1 & 0 & 1 \\
\end{array}
\]

11-4-3 Laplacian

A Laplacian filter is different from a Roberts or Sobel filter in that it finds the differential between a pixel and its neighbors in the four cardinal directions. Its kernel is as follows:

\[
\begin{array}{ccc}
0 & -1 & 0 \\
-1 & 4 & -1 \\
0 & -1 & 0 \\
\end{array}
\]

11-5. Custom

Custom filters can be applied to images. User-defined kernels are currently limited to a size of 3x3.

11-5-1 3x3 Convolution

The user may decide what weight is given to each pixel in the kernel which has a 3x3 size.
Chapter 12. Flatten

The Flattening processing tool removes artifacts that result from the slope and curvature produced by the scanning process. These artifacts can affect the height data of the image and make the image difficult to interpret.

Slope results from the fact that the sample surface will always be tilted to some extent relative to the plane of the XY scanner. Also, slope can be caused by the XY scanner not moving in a plane perpendicular to the Z scanning direction. Curvature is mainly caused by the out-of-plane motion of the XY scanner while scanning the sample.

During the flattening process, XEI first obtains the 'fitting curve' for each scan lines in the image. 'Fitting curve' is an estimation of the 'slope' or 'curvature' introduced in the image. Then, from each scan line in the image, XEI 'subtracts' the corresponding fitting curve. As a result, the 'offset' between the each point on the scan line and the each corresponding point on the fitting curve is obtained. This 'offset' is assigned as a new data for the each point. Figure 12-1 shows short example showing flattening applied to a single line.

![Figure 12-1. 1D example of the flattening](image-url)
12-1. Flatten Process Dialog

To display the Flatten process dialog, select ‘Process>Flatten’ in the Menu or click the ‘Flatten’ icon in the Toolbar. Figure 12-1-1 shows the Flatten process dialog which is composed of several parts. The Image display panel shows the original image and the processed image. At the upper-right side of the Image display panel is the Region selection toolbar composed of several buttons that include and exclude regions for flattening. At the lower-right side of the Image display panel are several parameters used to flatten an image. At the right side of the Image display panel is the Line Profile panel which displays the average height profile and the fitting curve for flattening an image. Below the Image display panel is the Histogram of the entire image for height restriction.

![Flatten process dialog](image)

Figure 12-1-1. Flatten process dialog

The Flatten process dialog provides some parameters that are useful for applying different flattening techniques. These are described further in the following section.
12-1-1. Image Display Panel

The Image display panel displays an original image and a flattened image. After adding regions, it also shows the regions as partially transparent shapes. If the Scope is set to ‘Line’, you will see a movable line locator in the Image Panel (for example, the red horizontal line with the two-arrow cursor in an image of Figure 12-1-1).

12-1-2. Region Selection Toolbar

The Region selection toolbar is composed of several buttons that include or exclude any regions in an image. Data points that are in the included regions are collected to calculate fitting curves and data points that are in the excluded regions are not used. The function of the region selection toolbar is summarized below.

- Inclusion - Sets selected regions to be included in the fitting curve
- Exclusion - Sets selected regions to be excluded from the fitting curve
- Rectangle - Selects a rectangular region
- Ellipse - Selects an elliptical region
- Polygon - Selects a polygonal region
- Entire region - Selects entire image

To select a region type

To specify the features of the image to be included and excluded, select the region type (rectangle, ellipse, and polygon) and create the regions in the image that will be included or excluded areas of the image. The shape and size of the selected region can be adjusted by dragging each small round tracker which is generated when you click any location within the selected region.

Especially, in the case of the polygonal region, after selecting the polygon in the Region selection toolbar, click the cursor onto any place where you want to create the region and then, move and click once onto each point of the polygon. Changing the shape and size of the polygon region is performed by the same steps described in the Region Analysis section. In addition, to move the selected region you have
already created, click the cursor in the selected region and drag the four-way arrow to reposition the region.

After selecting and grouping regions to be included and excluded for flattening, the Line profile automatically calculates and displays the average height profile and the fitting curve.

12-1-3. Histogram Panel

As shown in Figure 12-1-2, the Histogram panel shows a bar graph showing the distribution of heights in the image. The x axis is the height of data points in the sample surface, and the y axis is the number of data points. The Histogram panel has a pair of height restriction markers that restrict height range of data. One marker that has a flag directing right represents a lower limit and the other marker that has a flag directing left represents an upper limit. You can drag these markers to determine the height range to be included. Data points that have heights in the restricted height range are included and that have heights out of the range are excluded when calculating fitting curves. Included heights are painted with the original palette and excluded heights are painted with violet in the Palette panel, Image display panel, and the Histogram panel.
12-1-4. Flattening Parameters

**Scope**

The Scope is a range for collecting data and calculating a fitting curve that will be used for flattening. The flattening process collects data in the scope to calculate a fitting curve. The calculated fitting curve will be subtracted from the original image during flattening. There are two scopes: Whole and Line.

If the ‘Whole’ scope is selected, included data are used to calculate an average line profile and its fitting curve. The average line profile shows overall features of the image and the fitting curve calculated from this average line profile shows an overall distortion of the image. The fitting curve is subtracted from the entire image. The Line Profile panel displays this average line profile and its fitting curve.

If the ‘Line’ scope is selected, included data are used only to calculate a fitting curve for each line profile. Each fitting curve is subtracted from each line profile. In this scope, a movable line locator appears on the Image display so that you can examine a line profile at the locator and see its fitting curve in the Line Profile panel.
You can move this line locator easily by dragging it. Whenever you move the line locator, the line profile is automatically updated.

### Orientation

Orientation indicates the direction of the flattening process. If the ‘Horizontal’ orientation is selected, a horizontal slope and curvature will be removed. The same manner is applied for the ‘Vertical’ orientation. In the ‘Whole’ scope, all line profiles of the selected orientation are averaged to calculate a fitting curve for an overall image. In the ‘Line’ scope, a movable line locator that lies in the selected orientation appears on the Image display panel. You can examine a line profile of the selected orientation as well as the corresponding fitting curve.

In general, you may need to flatten an image both in the horizontal and vertical directions to eliminate all directional slope and curvature components from the image.

### Regression Order

The Regression order is the order of a regression polynomial selected for flattening. A fitting curve is calculated by polynomial regression. There are four possible regression orders: the zeroth, first, second, and the third. Each is denoted by 0, 1, 2, and 3. The zeroth order subtracts a constant from each line. The first order is used to remove a slope caused by a slanted scan plane relative to the sample plane. The second order is used to remove curvature caused by a bending motion of the XY scanner. The third order is for eliminating more complex distortions, but is rarely used.

### 12-1-4. Line Profile Panel

The Line profile panel displays both the line profile (red curve) and the fitting curve (blue curve) for flattening this Line Profile panel. In the Whole scope, this profile is an overall line profile. In the Line scope, this profile is a line profile located by a line locator in the Image display panel. The red curve is the line profile only for the included data and dashed lines are displayed for excluded data. A blue curve displayed simultaneously with the red curve is a fitting curve for flattening. The fitting curve is calculated only with the included data. Figure 12-1-3 shows two images before (left) and after (right) flattening. You can confirm whether the flattening process is executed well to see that the fitting curve becomes “flat” after executing the process.
Flattening is carried out through three processes. As soon as you open the Flatten process dialog, the software determines automatically the average curvature and slope of the image. Then, the software calculates a set of values that will compensate for the slope and curvature. Finally, you can have the software subtract the compensating values from the data points of the image.

You can follow this general steps for eliminating the slope and curvature of the image (see Figure 12-2-1):

1. Load the image you want to flatten into the Image display panel.
2. Select the Flatten menu or click the ‘Flatten’ icon to open the Flatten process dialog.
3. Select the Orientation for flattening, appropriate Scope.
4. Create regions of the image to be included and/or excluded from the calculation of the fitting curve. If necessary, restricts heights using height restriction makers in the Histogram panel.
5. Select the Regression order, which determines the type of slope or curvature to be eliminated.

6. Adjust some parameters to get desirable fitting curves and click the ‘Execute’ button if desired.

7. Save, export or print this image for further processing and analysis if desired.

It may be necessary to flatten an image in both the horizontal and vertical directions and also to execute the image flattening using more than one regression order in subsequent steps to remove both curvature and slope from an image.

**NOTE!**

Applying the Flattening process to an image produces a new, processed image that can be saved or printed as a new file. Flattening does not change the original data.

Figure 12-2-1 shows the summarized procedure to flatten the selected region in an image.
Figure 12-2-1. Procedure to flatten an image
Chapter 13. Deglitch

Deglitching is used to remove glitches from an image. A glitch is a small artifact in an image that does not represent the true surface topography. You can apply deglitching in both the horizontal and vertical directions.

Usually, glitches occur in the fast scan direction and appear as discontinuities or streaks in an image. Long glitches are sometimes caused by loose, unidentified particles on the surface that are dragged by the tip.

13-1. Deglitch Process Dialog

To open the Deglitch process dialog, select ‘Process>Deglitch’ in the Menu or click the ‘Deglitch’ icon in the Toolbar.

![Image Display Panel Zoomed Image Display Panel Shape Selection Toolbar](image.png)

Figure 13-1-1. Deglitch process dialog
As shown in Figure 13-1-1, the Deglitch process dialog is composed of two main parts; Image display panel and Zoomed Image display panel. At the left side, the Image display panel shows the original or processed image. At the right side, there is the Zoomed Image display panel with a Shape selection toolbar that is used to perform the glitch removal. Horizontal and vertical lines may be used as well as points.

13-1-1. Image Display Panel

The Image display panel displays an original image and a deglitched image. There is a red outlined square that indicates a zoomed region. After adding lines or points for deglitching, they will be displayed as dashed lines (Figure 13-1-1).

13-1-2. Zoomed Image Display Panel

The Zoomed Image display panel displays the magnified image of the zooming square. The Zoomed Image display panel magnifies the image dynamically while the zooming square is moved. Figure 13-1-2 shows that some glitch (see white outlined circles) disappear in the image after deglitching it in the Deglitch process dialog.

Figure 13-1-2. Deglitched image
13-1.3. Shape Selection Toolbar

The Shape selection toolbar has both a horizontal and a vertical line button and a point. If you select the horizontal or vertical line button, you can generate related lines in the Zoomed Image display panel pixel by pixel (dashed line as shown in Figure 13-1-1). The drawn lines are also displayed in the Image display panel. You can deglitch the lines or points that you selected by clicking the ‘Execute’ button.

13-2. Deglitch an Image

Deglitching is processed according to the rule that glitches are replaced by the lines of pixels through the average filter. For deglitching a horizontal line, every pixel in the line you select is substituted by the average of its top neighbor and its bottom neighbor. A line can be selected that extends across the entire image. For deglitching a vertical line, every pixel in the line you select is substituted by the average of its left and its right neighbor. Points are deglitched by getting the average of four neighbor pixels, one from each cardinal direction.

The procedure to deglitch an image is as follows (see Figure 13-2-1):

1. Load the image you want to deglitch into the Analysis view.
2. Select ‘Process>Deglitch’ in the Menu or click the ‘Deglitch’ icon in the toolbar to display the Deglitch process dialog.
3. Move the zooming square to where you want to deglitch in the image.
4. Decide what shape (line or point) to deglitch with. Place the cursor in the Zoomed Image display panel and click the cursor onto glitches.
5. Preview the changes in the Image display panel after clicking the ‘Execute’ button executing the deglitching process. Update the deglitched image into the Analysis view if desired.
6. Save, export, or print this processed image for further analysis and processing

NOTE!

Applying the Deglitching process to an image produces a new, processed image that can be saved or printed as a new file. Glitch removal does not change the original data.
Figure 13-2-1. Procedure to deglitch an image
Chapter 14. Fourier Filter

You can use the Fourier Filter to remove unwanted frequency components from your data. A Fourier Filter is most commonly used to remove periodic noise that appears in an image, for instance, due to electrical noise or mechanical vibrations. A 2-dimensional power spectrum of an image may be used to identify periodic noise. In the power spectrum, periodic noise will appear as a vertical band running through the center of the power spectrum. This noise can be removed by applying a Fourier Filter. Also, a Fourier Filter may be used to remove a selective frequency component from actual surface data. This technique is often applied in presenting atomic lattice data. In this case, a Fourier Filter is applied that includes only the frequencies that represent the symmetry of the atomic lattice.

14-1. Fourier Filter Process Dialog

To open the Fourier Filter process dialog, select the ‘Process>Fourier Filter’ option in the Menu or click the ‘Fourier Filter’ icon in the Toolbar.

As shown in Figure 14-1-1, the Fourier Filter dialog consists of an Image display panel and a 2D power spectrum display. On the left side, there is the Image display panel which shows the original image to which the Fourier Filter will be applied and will also show the transformed image after you have applied the Fourier Filter. At the right side of the Image display panel is a 2-dimensional power spectrum which includes a palette panel as well as tools used to either include or exclude regions (rectangle, ellipse, polygon or entire region) to be filtered.
When you open the Fourier Filter process dialog, the Fourier transform of the selected image is automatically calculated. The resulting power spectrum is displayed in a different color. Figure 14-2-1 shows the general 2D power spectrum which all height data in the spatial domain are converted to the frequency domain after Fourier transform. Peaks in the power spectrum appear bright on a dark background, and also, different colors are displayed in different intensities of frequency components in the data. You can adjust this scale using the palette panel to see various peaks in the power spectrum more clearly.

The unit of the z scale in the power spectrum is displayed at the left side of the palette panel as Å×µm², µm ×µm², V×µm², Å×nm², nm ×µm², V× Å² and so on that depending on the unit you selected as an input signal in the Input configuration dialog when the image was initially acquired. The units of x and y in the power spectrum are 1/µm, that is, the reciprocal of each unit of x and y in the image.

In a power spectrum, the x scan direction is displayed horizontally and the y scan direction is displayed vertically. Lower frequencies are near the origin and higher frequencies are further from the origin. Peaks in the power spectrum are symmetric about the origin.

Each spatial frequency in the real spatial image is represented by a peak in the power spectrum. Peaks can be due to actual surface periodicities such as the spacing between lines on a grating of a standard sample or the spacing between rows
of atoms on a graphite surface. Peaks may also result from periodic noise. To apply the Fourier Filter to unwanted frequency components, remove or reduce the intensities of the unwanted peaks in the power spectrum.

Figure 14-2-1. 2D power spectrum

14-3. Apply the Fourier Filter to an Image

A selective Fourier filter allows you to remove specific frequency components from the power spectrum of an image. This process is commonly used to remove peaks attributed to periodic noise. Furthermore, it can be useful when you wish to take an image with only chosen periodicities by including only those peaks in which you are interested.

In Fourier filtering, you select a region type to be used for including or excluding frequency components in the power spectrum. You can remove all periodic noise by excluding frequency components within the included region.

Since peaks in the power spectrum are reflected across the origin, both a selected region and its reflected region will be generated together.
You can apply the Fourier filter to an image by following these general steps (see Figure 14-3-1):

1. Load the image you want to apply Fourier Filter into the Analysis view.
2. Open the Fourier Filter process dialog by selecting ‘Process>Fourier Filter’ in the Menu or by clicking the ‘Fourier Filter’ icon on the Toolbar. When you open the Fourier Filter process dialog, the entire power spectrum is automatically displayed.
3. Select a region type (rectangle, ellipse, polygon or entire region) you wish to use to include or exclude selected frequencies, and draw it around the desired spectral features in the power spectrum.
4. Click the ‘Execute’ button to preview the effect of the Fourier Filter. Update the image in the Analysis view by selecting the ‘OK’ button if desired.
5. Save, export, process or analyze the filtered real spatial image.

Figure 14-3-1 shows the general procedure to apply the selective Fourier Filter and also, you can see a comparison of an original image and a Fourier filtered image. Furthermore, Figure 14-3-2 shown below is the atomic lattice image which the selective frequency components were passed through the Fourier Filter.

**NOTE!**

Applying the Fourier Filter to an image produces a new, processed image that can be saved or printed as a new file. This application does not change the original data.
Figure 14-3-1. Procedure to apply the Fourier Filter to an image
Figure 14-3-2. Fourier Filter applied to Atomic lattice image
Chapter 15. Tip Estimation

As the size of the tip is finite, the images obtained by the SPM are affected by the shape of tip. In professional words, image of the tip is ‘convoluted’ to the image of the sample surface obtained with the tip (i.e. Tip Convolution). Tip Convolution generates error in the dimensions of the sample surface measured with the SPM. Figure 15-1 shows simple example how shape of the tip affects the dimensions of the hills and trenches measured with the SPM.

Figure 15-1. Example of tip convolution

To remove such an affect of the ‘tip convolution’, XEI offers ‘Tip Estimation’ process. During the ‘Tip Estimation’ process, XEI first ‘estimates’ the shape of the tip used to obtain the image. Then, XEI calculates the artifacts caused by tip and removes them from the loaded image. (Tip de-convolution)

This part of the manual is mainly focused on how to use the ‘Tip Estimation’
function of the XEI. For detailed information regarding the algorithm of the ‘Tip Estimation’ process, please refer to “Algorithms for Scanned Probe Microscope Image Simulation, Surface Reconstruction, and Tip Estimation” by J. S. Villarrubia. (Volume 102, Number 4, July–August 1997 Journal of Research of the National Institute of Standards and Technology)

15-1. Tip Estimation Process Dialog

To open the Tip Estimation process dialog, select the item from the Process menu or click the ‘Tip Estimation’ icon in the Toolbar.

As shown in Figure 15-1-1, the Tip Estimation dialog consists of two image display panel, one for the loaded image (Image Display Panel) and the other for the estimated tip shape (Tip Image Display Panel), and Parameters panel.

![Figure 15-1-1. Tip Estimation process dialog](image)

15-1-1 Image Display Panel

The Image display panel is on the left side shows the original image to which the tip deconvolution will be applied and will also show the transformed image after you have applied the deconvolution. Image before and after tip deconvolution is displayed in the Image Display Panel.
15-1-2 Tip Image Display Panel

2 dimensional representation of the estimated tip shape is displayed on ‘Tip Image Display Panel’. Also, the estimated tip shape can be saved and loaded for further analysis.

- Opening & Saving the Estimated Tip Shape

Estimated tip shape can be saved as a tiff file by clicking ‘Save’ button. The tiff file of the estimated tip shape will be saved under the same directory where the image loaded for “Tip Estimation” process is saved. The file name of the saved tip shape will be in forms of ‘File name of the image loaded for tip estimation process_tip.tiff’.

Saved tip shape can be loaded to the ‘Tip Image Display Panel’ later on and used as an estimated tip shape for other samples as well. To load the saved tip shape, click ‘Open’ button and browse to find the saved tip shape. Figure 15-1-2 shows a tiff file of the saved tip shape loaded in 3D view of the XEI.

![Figure 15-1-2. Estimated tip shape saved as tiff file](image)

Saving and loading the tip shape can be useful if you have more than 2 images that have been obtained using the same tip. You can save the tip shape estimated from one sample and load it to deconvolute other images that have been
obtained with same tip without repeating tip estimation process.

15-1-3 Parameters Panel

Parameters related to optimization of tip estimation and deconvolution process are controlled through this panel.

- **Priority**

  User can select to give priority of tip estimation and deconvolution algorithm to either ‘Speed’ or ‘Accuracy’. When the ‘Priority’ is given to ‘Speed’, XEI uses partial estimation algorithm to perform fast tip estimation and when the ‘Priority’ is given to ‘Accuracy’, XEI uses full estimation algorithm to perform more accurate tip estimation.

- **Tip size**

  Tip size can be set in units of the ‘pixels’. Selecting a appropriate tip size is important for good tip estimation results. Typical tip size that gives accurate estimation result is 0.04 to 0.2 of the image size. For example, if the size of the loaded image is 20um with 256 pixel size, typical tip size that will give good estimation result will be 10.24 to 51.2.

15-2. Applying Tip Estimation process to the Image

The tip shape will be automatically calculated when the dialog window is initialized. You can recalculate the tip shape if you have better knowledge of the actual tip size. Put the size (height and width) of the tip into the appropriate fields and click the Estimate button. A new estimation will be made.

Once a good approximation of the tip shape has been made, it can be applied to the image to remove artifacts created by the tip. This can be helpful for images including sheer slopes. Tip deconvolution is applied to the whole image. You can estimate the tip shape and apply the estimation to an image by following these general steps:

1. Load the image to which you want to apply tip deconvolution into the Analysis view.
2. Select Tip Estimation from the Process menu or click the ‘Tip
Chapter 15  Tip Estimation

3. Input the size of the tip, select priority, and then click ‘Estimate’ to calculate the shape of the tip. If you had estimated the shape of the tip that was used to obtain the loaded image.

4. Click the ‘Execute’ button to preview the effect of the tip deconvolution. Update the image in the Analysis view by selecting the ‘OK’ button if desired.

5. Save, export, process or analyze the new image.

**NOTE!**

Applying the Tip Estimation process to an image produces a new, processed image that can be saved or printed as a new file. This application does not change the original data unless you click Save button.

Figure 15-2-1 shows the resulting image when the estimated tip shape is applied to the original data.

Before Deconvolution – measured width of trench (4.5um) is smaller than its known width 5um due to the effect of tip convolution.

After Deconvolution – Tip shape is deconvoluted from the image and now the measured width of trench (6um) matches the known width 5um.

**Figure 15-2-1. Application of Tip Estimation**

In actual experiments, there is special sample designed for tip shape
estimation. Accurate tip shape can be obtained when the tip shape is estimated from the image of this sample. Then, the estimated tip shape can be loaded for tip deconvolution of other images measured with same tip.
Index

2
  2D Power Spectrum 128
  3D view 21, 83, 84

3

A
  Analysis 17
  Analysis tab 3
  Analysis view screen 3
  arithmetic filter 107

B
  Bearing Ratio 62

C
  Contrast
    Level Adjustment 32
    Max 31
    Min 31
    range 31
  Copy 16
  Crop 103
  Crop Process Dialog 103
  Cut 15

D
  Data Gain 38
  Deglitch 26, 123
  Delete 7, 16
  Delete All 7

E
  Edit 15
  Effect 28
  Enable Ambient Light 91
  Enable Perspective 92
  Exclusion 57, 115
  Exit 14
  Export 12, 47, 61

F
  F182
  Fast Scan Dir 37
  Fast Scan direction 36
  File 9
  Fill Border 96
  Filter 24
  Filter Level 70
  Filter process dialog 107
  Flatten 24
  Flattening 113
Fourier Filter 26 Line selection toolbar 42
Fourier Filter 127 Line Statistics table 50
Full Line view 18, 39, 41
Data range 31 Load 7
Palette Range 31 Low Pass 109
Low Pass Filter 36
Luminosity 91

G
Gaussian Blur 109 glitch 123

M
Max 51, 64
Mean 51, 64
Mean Filter 108
Median 109

H
Height Restriction Markers 60 Menu Bar 2
High Pass 110 Mid 51, 64
Min 51, 64

I
Move Tool 59
Image
Line 45
Export 34 Multi view 21, 99
Load 33

N
Navigator View 5

O
Orientation 118 Over Scan 36

K
kernel matrix 107

P
P12 82
Palette 28

L
Palette panel 30
Paste 16
Position 91
Power Spectrum Panel 49
Preferences 14
Preview 11

Line histogram 50 Power Spectrum Panel 49
Line Profile Panel 46, 118 Preferences 14
Line scope 117 Preview 11
<table>
<thead>
<tr>
<th>Action</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print</td>
<td>14</td>
</tr>
<tr>
<td>Priority</td>
<td>136</td>
</tr>
<tr>
<td>Process</td>
<td>23</td>
</tr>
<tr>
<td>PSD 2D</td>
<td>80</td>
</tr>
<tr>
<td>PSD Graphs</td>
<td>79</td>
</tr>
<tr>
<td>PSD View</td>
<td>77</td>
</tr>
<tr>
<td>PSD X(Y)</td>
<td>80</td>
</tr>
<tr>
<td>PSD1</td>
<td>82</td>
</tr>
<tr>
<td>PSIA Version</td>
<td>35</td>
</tr>
</tbody>
</table>

- **R**
<table>
<thead>
<tr>
<th>Action</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ra52, 65</td>
<td></td>
</tr>
<tr>
<td>Range</td>
<td>51, 65</td>
</tr>
<tr>
<td>Redo</td>
<td>15</td>
</tr>
<tr>
<td>Reflexibility</td>
<td>91</td>
</tr>
<tr>
<td>Region Histogram Panel</td>
<td>60</td>
</tr>
<tr>
<td>Region selection toolbar</td>
<td>56</td>
</tr>
<tr>
<td>Region Selection Toolbar</td>
<td>115</td>
</tr>
<tr>
<td>Region Statistics table</td>
<td>64</td>
</tr>
<tr>
<td>Region view</td>
<td>18, 53</td>
</tr>
<tr>
<td>Region View</td>
<td>55</td>
</tr>
<tr>
<td>Regression Order</td>
<td>118</td>
</tr>
<tr>
<td>Reopen</td>
<td>7</td>
</tr>
<tr>
<td>Resolution</td>
<td>87</td>
</tr>
<tr>
<td>Restore Defaults</td>
<td>98</td>
</tr>
<tr>
<td>Restore Grain</td>
<td>73</td>
</tr>
<tr>
<td>Rku</td>
<td>52, 65</td>
</tr>
<tr>
<td>RMS</td>
<td>52, 65</td>
</tr>
<tr>
<td>Roberts</td>
<td>110</td>
</tr>
<tr>
<td>Rotation</td>
<td>90</td>
</tr>
<tr>
<td>Rotation Angle</td>
<td>37</td>
</tr>
<tr>
<td>Rq12</td>
<td>82</td>
</tr>
<tr>
<td>Rsk</td>
<td>52, 65</td>
</tr>
<tr>
<td>Rz52, 65</td>
<td></td>
</tr>
</tbody>
</table>

- **S**
<table>
<thead>
<tr>
<th>Action</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Bias</td>
<td>37</td>
</tr>
<tr>
<td>Sampling Number</td>
<td>88</td>
</tr>
<tr>
<td>Save</td>
<td>11</td>
</tr>
<tr>
<td>Save As</td>
<td>11</td>
</tr>
<tr>
<td>Save warning</td>
<td>11</td>
</tr>
<tr>
<td>Scale</td>
<td>90</td>
</tr>
<tr>
<td>Scan Rate</td>
<td>37</td>
</tr>
<tr>
<td>Scope</td>
<td>117</td>
</tr>
<tr>
<td>Select All</td>
<td>16</td>
</tr>
<tr>
<td>Set Point</td>
<td>37</td>
</tr>
<tr>
<td>Show Hills</td>
<td>73</td>
</tr>
<tr>
<td>Show Number</td>
<td>73</td>
</tr>
<tr>
<td>Show Plane</td>
<td>97</td>
</tr>
<tr>
<td>Show Valleys</td>
<td>73</td>
</tr>
<tr>
<td>Show Wire Frame</td>
<td>93</td>
</tr>
<tr>
<td>Show XY Axis</td>
<td>94</td>
</tr>
<tr>
<td>Show Z Axis</td>
<td>95</td>
</tr>
<tr>
<td>Sine Scan</td>
<td>36</td>
</tr>
<tr>
<td>Slow Scan Dir</td>
<td>37</td>
</tr>
<tr>
<td>Sobel</td>
<td>111</td>
</tr>
</tbody>
</table>

- **T**
<table>
<thead>
<tr>
<th>Action</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>68</td>
</tr>
<tr>
<td>Tip Bias</td>
<td>37</td>
</tr>
<tr>
<td>Tip Estimation</td>
<td>133</td>
</tr>
<tr>
<td>Tip shape</td>
<td>135</td>
</tr>
<tr>
<td>Tip size</td>
<td>136</td>
</tr>
<tr>
<td>Title Bar</td>
<td>2</td>
</tr>
<tr>
<td>Toolbar</td>
<td>3</td>
</tr>
<tr>
<td>Transform</td>
<td>89</td>
</tr>
<tr>
<td>Translation</td>
<td>90</td>
</tr>
</tbody>
</table>

- **U**
<table>
<thead>
<tr>
<th>Action</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>15</td>
</tr>
<tr>
<td>W</td>
<td>Y</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Watershed</td>
<td>69</td>
</tr>
<tr>
<td>Whole scope</td>
<td>117</td>
</tr>
<tr>
<td>X Offset</td>
<td>37</td>
</tr>
<tr>
<td>Z</td>
<td>Z</td>
</tr>
<tr>
<td>X</td>
<td>Zoomed Image Panel</td>
</tr>
<tr>
<td>X Offset</td>
<td>37</td>
</tr>
</tbody>
</table>
Customer’s Document Feedback Form

In an effort to ensure that the content of this manual is updated and accurate, PSIA welcomes any and all customer feedback.

If, during the course of using this manual, you come upon any errors, inaccuracies, or procedural inconsistencies, or if you have other content suggestions, please take the time to forward your comments to us for consideration in future manual revisions.

Please check (V) that you think this comment is critical ( ) or moderate ( ) or minor ( ).

Comments:

Customer Information

Name: ___________________________ Date: _____________

Company/Institution: ___________________________

Address: ___________________________

Country: ___________________________

System model: ___________________________

E-mail: ___________________________

Fax: ___________________________

Phone: ___________________________

You may fax this form or e-mail to PSIA:

Homepage: http://www.advancedspm.com

E-mail: info@advancedspm.com

Address Induspia 5F, Sang-Daewon-Dong 517-13, Sungnam,

Fax Korea 462-120

Phone +82-31-734-2995

+82-31-734-2900